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Getting Started

Introduction to Collier TopForm™ & File

Collier TopForm™ & File is a powerful Windows® -based application that enables you to efficiently fill out and transmit
the forms required to commence a bankruptcy case. Collier TopForm & File is equipped with features that enable you to
manage your cases effectively and efficiently.

Designed to operate on either single-station or networked computers, Collier TopForm & File contains all of the forms and
schedules necessary to prepare filings for Chapter 7, 11, 12, and 13 cases. It also includes tools to help you analyze data
you know about your client to determine whether he or she should file a Chapter 7 or a Chapter 13 case. Additionally, if
you need to request a credit report for your client, you can use the Due Diligence tools available within Collier TopForm
& File. The program also provides options for automatically e-filing cases with most courts. You can also print the
documents associated with your cases.
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System Requirements

Before you install Collier TopForm™ & File, make sure your system meets the following hardware and software
requirements:

Computer and processor: Intel®  processor or compatible 1 GHz or faster processor (2 GHz or faster is
recommended)

Memory: 2 GB of RAM or higher

Hard Disk: 2 GB (standalone and network client); 3 GB (network admin)

Note:
Additional disk space may be needed as updates are installed and cases are created.

Operating System:
o Windows XP (32-bit) SP3
o Windows XP (64-bit) SP2
o Windows Vista (32-bit and 64-bit) SP2
o Windows 7 (32-bit and 64-bit) SP1
o

Windows 8 and Windows 8 Pro x64 and x32 / Windows 8.1 and Windows 8.1 Pro x64 and x321

o Windows Server 2008 (32-bit and 64-bit) SP2
o Windows Server 2008 R2 (64-bit) SP1
o Windows Server 2012 / Windows Server 2012 SR2

PDF Viewer: Adobe Reader version 9 or higher

Note:
An internet connection is also required in order to download updates to the program.
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Professional Responsibility

The materials you have licensed are designed to assist you in your professional practice. It is still your responsibility
to review the forms and to research the results to determine their accuracy and whether they are sufficient for your
purposes. The materials and legal annotations contained herein are intended as a supplement to and not a substitute for
your professional judgment.

All information provided in this documentation is general in nature and is provided for educational purposes only. It should
not be construed as legal advice. For legal advice applicable to the facts of your particular situation, you should obtain the
services of a qualified attorney licensed to practice in your state.
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Contact LexisNexis

If you need assistance while using Collier TopForm™ & File, please use one of the following telephone numbers:

Reason for Calling Department Telephone Number

If you are having difficulty
installing or using the
software, or if you
encounter an error message

Technical Support 1-800-223-5297

Note:
Technical Support is available Monday
through Friday, from 7 a.m. to 12
midnight ET. When calling for technical
assistance, please be at the computer
on which the program is running, and
please have your account number
ready.

If you have questions about
your account

Customer Service 1-800-833-9844
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Getting Help While Using Collier TopForm™ & File

You can access the Collier TopForm™ & File help file at any time while you use the product by clicking either the Help

link in the File menu, or by clicking the Help icon ( ) in the upper-right corner of the Collier TopForm & File window. The
help file contains information that can help you use Collier TopForm & File.

The help file includes options for accessing information in it:

Click the Home link in the Help window navigation bar to view the main "table of contents" for the help file. This
displays a page that describes sections of the help file. You can click a folder and navigate to the specific help topic
that most interests you.

Enter a search term or phrase in the Search box and click Search to view topics that contain your search phrase. If
the search phrase is found, a Search Results page is displayed, showing the different topics, grouped by category,
that meet your criteria.

Note:
See Form a Help Search Query for detailed instructions on creating a help search query.

Printing or Saving Individual Help Pages

To print the help page you are viewing, click the Print icon ( ) near the top-right corner of the page.

To save the help page as a PDF document, click the PDF icon ( ) near the top-right corner of the page.

Resizing Text

To make the help text size larger, click the Increase font size icon ( ). To make the help text size smaller, click the

Decrease font size icon ( ).



Collier TopForm® & File User Guide

6

Additional Sources of User Information

While using Collier TopForm™ & File, you can find answers to questions you may have using the following resources:

Collier TopForm & File Help: The Collier TopForm & File help file contains information on using the different tools
available within the program. You can access the Collier TopForm & File help file either by clicking the Help link

located in the File menu, or by clicking the larger Help button ( ) in the upper-right corner of the program window.

Additionally, to access context-specific help, click the smaller Help button ( ) in the upper-right corner of any page
or pod that includes such a button.

Form Guidance: When you complete the various forms required by your bankruptcy filing, some of the forms may
include guidance to help you understand what's required by the form. This material usually appears as the first
dialog (or page) during the form interview question process, and it’s titled something like <<Form 1 Guidance>>.
This content is provided by LexisNexis experts on the bankruptcy process.

Form Interview Resources: During form interviews, some questions include tips for answering specific questions.
This information may appear in a yellow-colored "resource" pane just below the interview questions. Additionally,

fields that have this type of help available are marked using a special Help button ( ), which appears to the right of
the answer field. To view the resource in a pop-up dialog box, click this button.

If you have questions about basic Windows®  functionality, such as moving and sizing windows, arranging overlapping
windows, and navigating within windows, refer to your Windows documentation. You can also find helpful information by
clicking the Start menu, located on the taskbar in the lower-left corner of your Windows desktop, and pointing to Help.
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Security Notice

Collier TopForm™ & File is a software application that stores information on the user's computer systems through
databases, text files, and forms. It is your responsibility to protect the stored information through appropriate information
security and physical security policies and practices. Additionally, insofar as you may transmit forms containing personal
information, it is your responsibility to protect such information during transmission.
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How do I start Collier TopForm™ & File?

To begin creating, managing, and filing bankruptcy cases, you must first start the Collier TopForm™ & File program.

To do this:

1. On your Windows®  desktop, click the Start menu. The start menu is displayed.

2. On the Programs menu, open the LexisNexis folder and then choose Collier TopForm™ & File 12. The
application is launched.
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How do I exit Collier TopForm™ & File?

When you finish your session, you can quit Collier TopForm™ & File using one of two methods.

To quit the program :

Choose one of the following options:
o From the File menu, choose Exit.
o In the upper-right corner of the main window, click the Exit button.
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About Importing Collier TopForm™ Bankruptcy 10.5.x Cases

If you are migrating from using Collier TopForm™ Bankruptcy Filing Program version 10.5.x, the first thing you'll notice is
that this new version of Collier TopForm™ & File is completely new, both in appearance and in functionality. A lot of effort
has been made to improve the program and streamline the process of completing a case from start to finish.

One of the major changes was to improve the way firm and client data flows between the program itself and the forms you
must complete to file a case. With these new changes, you should only need to enter data once, and as you complete
other forms, fields requiring the same information should automatically have this information filled in. This answer flow-
through greatly decreases the time spent completing all of the required forms, schedules, and ancillary documents
required as part of the filing process.

Collier TopForm & File 13 includes a tool to import settings and cases from Collier TopForm Bankruptcy 10.5. Every effort
has been made to ensure that the tool imports and maps the data coming from version 10.5 to data used in version 13.
However, not all data was able to be mapped correctly. For example, in Collier TopForm Bankruptcy 10.5, addresses
(including street, city, state, and zip) were saved as one "chunk" of text. However, in Collier TopForm & File 13, addresses
are saved as distinct pieces of data (e.g., street is one answer, city is another answer, and so forth). Because of this
discrepancy between the two versions of the product, we were unable to map the single chunk of data coming from
version 10.5 to its individual parts in version 13. Instead, the full address coming from version 10.5 is mapped to just the
street address in version 13.

Because of these discrepancies, if you choose to import your cases from Collier TopForm Bankruptcy 10.5, you must
review each of the forms and correct any data that was imported incorrectly. To help you identify which forms need to be
reviewed after you've imported your cases, Collier TopForm & File creates a log file which lists these forms, along with the
data that needs to be checked. You can find this log file in the Logs subfolder of the Collier TopForm & File program folder
(for example, C:\Users\YourUserName\Documents\LexisNexis\TopForm\Logs).

Other Things to Note After You Import Your Cases

When importing the data for Form 7, Collier TopForm & File may not be able to distinguish between debtor and
co-debtor information. As such, you should review Form 7 for each case you imported and make corrections, if
necessary.

Once you have reviewed cases listed in the log file, you must review the data in each schedule. This step is required
if you plan to electronically file or print these forms later. To view the schedules, open the case (either at the File
menu or at the Dashboard menu), and then view the schedules at the Forms subtab.

Additional data you may want to review includes phone numbers, dates, and social security numbers, all of which
may not be formatted properly, as well as exemption laws, which may not have matching statute titles in version 13.

Please see How do I import cases from Collier TopForm 10.5? for instructions on importing your cases.
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How do I import cases from Collier TopForm 10.5?
Caution:

Before importing your existing cases into Collier TopForm™ & File, please review the help topic About Importing
Collier TopForm™ Bankruptcy 10.5.x Cases.

Only those preferences and cases you worked with using Collier TopForm 10.5 and later will be available to be
imported.

When you first upgrade from Collier TopForm Bankruptcy 10.5 and then launch Collier TopForm & File after installing it,
you are prompted to import your preferences (such as firm and attorney information, as well as your master address list).
You are also prompted to import those most recent cases you have worked on. You can import your data this first time
you launch the product, or you can import it at a later time.

To import Collier TopForm Bankruptcy 10.5 cases into the current version of Collier TopForm & File:

1. To start the import process, complete one of the following steps:

If you are importing cases as the final step in the installation process and you are already viewing the Import
Data dialog box, skip to Step 2.

If you are importing cases separate from the installation, choose Import Data from the Collier TopForm & File
File menu. Then choose Collier TopForm(TM) Bankruptcy 10.5 from the Import data from drop-down list.

2. Select the preferences you want to import in the Preferences section.

3. Select the cases you want to import in the Cases section.

4. Click Import.
If Collier TopForm & File experiences problems while importing the data, it displays a message at the end of the
process, indicating that it created a log file. This file lists the data that was either not imported, or it lists data that
you'll need to review because data from Collier TopForm Bankruptcy 10.5 could not be mapped properly to fields in
Collier TopForm & File 13. This log file is typically stored in the Logs subfolder of the Collier TopForm & File program
folder (for example, C:\Users\YourUserName\Documents\LexisNexis\TopForm\Logs).

5. If necessary, review the log file and make the necessary data corrections in the listed forms.
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Initial Filing Documents

The following table describes some of the different schedules and forms you may be required to complete for your
bankruptcy filing:

Note:

When you complete the various forms required by your bankruptcy filing, some of the forms may include
guidance to help you understand what's required by the form. This material usually appears as the first dialog (or
page) during the form interview question process, and it's titled something like "<< Form 1 Guidance >>". This
content is provided by LexisNexis experts on the bankruptcy process.

See Additional Documents for a list of other required forms.

Schedule Name Description

Schedule A: Real Property Real property refers to items such as houses, cabins, and land. All of the debtor’s
interests in real property except leasehold interests listed on Schedule G must be listed
on Schedule A.

Schedule B: Personal
Property

Personal property refers to items such as automobiles, boats, and clothing. All personal
property of the debtor must be listed in Schedule B.

Schedule C: Property
Claimed as Exempt

Schedule C summarizes the exemption status of the debtor’s real and personal property.
Information you enter while completing Schedule A and B automatically flows to and is
displayed in Schedule C so that you can review and validate that you have taken the
proper exemptions. Should you need to edit exemption assignments, you can do so
directly in Schedule C.

Schedule D: Creditors
Holding Secured Claims

Schedule D details claims for which there is an outstanding past-due amount. All
creditors holding secured claims against property of the debtor must be listed in Schedule
D.

This information is transferred to the Chapter 7 Statement of Intention Regarding
Secured Debts form. Information about the choices available in completing this form is
available in Collier Consumer Bankruptcy Practice Guide ¶6.12.

The program feeds this information to Schedule H, where co-debtors on any debts of the
debtor must be listed. Schedule H is discussed further in Collier Consumer Bankruptcy
Practice Guide ¶6.07[4].

Schedule E: Creditors
Holding Unsecured Priority
Claims

Schedule E details creditors whose claims are unsecured. All creditors holding unsecured
priority claims against the debtor must be listed in Schedule E.

Detailed information about completing Schedule E is available in Collier Consumer
Bankruptcy Practice Guide ¶6.07[2][b].

Schedule F: Creditors
Holding Unsecured
Nonpriority Claims

Schedule F details creditors whose claims are unsecured. All creditors holding unsecured
nonpriority claims against the debtor must be listed in Schedule F.

Schedule G: Executory
Contracts and Unexpired
Leases

Schedule G details executory contracts and unexpired leases and indicates whether
they will be rejected or assumed and, possibly, additional information depending on
jurisdiction. All executory contracts and unexpired leases of the debtor must be listed in
Schedule G.

Schedule H: CoDebtors Schedule H summarizes information related to co-debtors. Information entered while
completing Schedules D, E, and F automatically flows to and is displayed in Schedule H
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for purposes of your review and validation. Should you need to add or refine co-debtor
assignments to claims, you can do so directly in Schedule H.

Schedule I: Current Income
of Individual Debtors

Schedule I details income of the debtors, and the income of all debtors must be listed in
Schedule I. The schedule primarily requires numeric data related to the debtor and the
debtor’s spouse, if any.

Schedule J: Current
Expenditure of Individual
Debtors

Schedule J details expenses of the debtors and, when applicable, of the debtor’s spouse,
debtor’s business, and debtor’s spouse’s business. All of the debtor’s current expenses
must be listed in Schedule J.

Summary of Schedules The Summary of Schedules outlines important details about your case, including the
following:

The schedules you have selected to include in your filing

The number of pages that will print for each schedule

Note:
Until the entire case is complete, the total page count may not be accurate.

Reviewing the Summary of Schedules is an important step in preparing an initial filing.

Form 7: Statement of
Financial Affairs

Form 7 must be filed in every case. The document contains 25 questions and
subquestions that appear numbered as they are on the official form.

Form 8: Chapter 7
Individual Debtor’s
Statement of Intention

The debtor must complete the Form 8 — Statement of Intention for each property that is
collateral for a secured debt. The information on Form 8 flows from Schedules D, E, F,
and G. If upon reviewing the information reflected in Form 8 you discover any mistakes,
you can post corrections here. When you do so, the program automatically updates the
corresponding schedule accordingly.

Form 22: Statement of
Current Monthly Income
[and Means Test or
Disposable Income
Calculation]

Form 22 must be completed for certain individual debtors filing Chapter 7, for individual
debtors filing Chapter 11, and for all debtors filing Chapter 13. The questions included
in Form 22 vary depending on chapter type: Chapter 7 and 13 cases contain questions
corresponding to the categories of information used in determining current monthly
income and calculating the Means Test (for Chapter 7 cases) or determining Disposable
Income (for Chapter 13 cases), and Chapter 11 cases contain questions for the gathering
of current monthly income data.

Form 23: Debtor’s
Certification of Completion
of Instructional Course
Concerning Personal
Financial Management

In all cases, Form 23 must be filed in order to alert the clerk that the debtor has satisfied
the requirement of completing an instructional course in personal financial management.

Form 24: Certification to
Court of Appeals by all
Parties

Form 24 must accompany appeals, bankruptcy court judgments, orders, or decrees
directly to the United States Court of Appeals.
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Additional Documents

Based on certain case variables, additional information and documents may be required for a filing. For instance, filings
for publicly traded corporations and partnerships must include details on stock as well as other financials. In such
instances, this information constitutes the basis for documents in addition to those that would otherwise be prepared for
an initial filing.

Other types of bankruptcy forms are grouped in the following categories, by default:

Emergency Forms: Emergency filings require documents that would otherwise be prepared for an initial filing
as well as additional documents. As an aid in preparing emergency filings as quickly as possible, the program
separately categorizes the necessary forms, displaying them together under the Emergency Forms folder in the
Forms list.

Other Bankruptcy Forms: Certain forms that apply to only certain types of cases may not be required as part of the
initial filing. These types of forms are typically listed in the Other Bankruptcy Forms folder.

Jurisdictional Forms: Some forms are required and provided by the jurisdiction in which you are filing. These forms
are available in this list.
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Sample Cases in Collier TopForm™ & File

When you install Collier TopForm™ & File, the program includes some sample data. Specifically, Collier TopForm & File
installs the Southern District of New York jurisdiction. It also installs a sample firm (named Jay & Jay) with two sample
representatives (named John Jay and Jane G. Jay). Finally, it installs two sample cases, James Madison and James
Monroe.

You can review these cases and settings to see how to you can use the program to create your own bankruptcy cases.
However, once you review these settings and cases, you may decide you want to remove them from the program:

To remove the Southern District of New York jurisdiction, go to Preferences > Jurisdiction Setup, click the Install
Jurisdictions tab, open the New York folder, and clear the Southern District of New York option. Then, click Yes
to confirm the removal.

To delete the firm and representative, go to Preferences > Firm Setup and click the Delete icon on the Jay & Jay
tab. Click Yes to confirm the removal.

To delete the cases, go to File > View Cases, locate the two cases in the list of cases, and click the Delete icon.
Click Yes to confirm the removal.

1  When launching Collier TopForm & File for the first time on Windows 8 /8.1 or Windows 8/8.1 Pro, you may receive a
security warning about Collier TopForm & File being unrecognized. To continue and use the program, click More Info at
this message, and then click Run anyway.
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Setting Collier TopForm™ & File Preferences

How do I add a jurisdiction?

One of the first tasks you must complete after installing Collier TopForm™ & File is to indicate the jurisdictions in which
you plan to file bankruptcy cases. By doing this, Collier TopForm & File knows which data sets (i.e., forms and other
supporting material such as applicable exemption laws) to initially make available for your use, as well as assumes certain
settings based on the chosen jurisdictions.

Additionally, because your practice domain may change, the program lets you add and remove jurisdictions at any time.

To add jurisdictional data sets:

1. From the Preferences menu, choose Jurisdiction Setup.

2. Click the Install Jurisdictions tab. A list of jurisdictions appears in the pane.

3. Choose the desired jurisdiction from the list by clicking the Expand button ( ) beside the applicable state listing,
then clicking the Expand icon beside the applicable district listing, and, where needed, selecting the district.

4. Once you select all of the applicable jurisdictions in which you practice, click Save. The jurisdictions are installed.

Once you install a jurisdiction, it is added to your list of installed jurisdictions. To configure it, click the Configure Installed
Jurisdictions tab. (See How do I configure jurisdiction settings?.)
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How do I configure jurisdiction settings?

Collier TopForm™ & File lets you specify whether you want to include explanatory text on the different schedules you
complete. This setting is division specific, meaning that any changes you make to the settings for any single division will
not carry over to other divisions within the same jurisdiction nor to other divisions within other jurisdictions.

To configure jurisdictional data sets:

1. From the Preferences menu, choose Jurisdiction Setup.

2. Click the Configure Jurisdictions tab. A list of jurisdictions appears in the pane.

3. Click the Expand icon ( ) for the jurisdiction you want to configure.

4. Select Print explanatory text on schedules if your jurisdiction requires that the explanatory text contained in the
Official Forms be included on the forms you submit. By default, this option is cleared to conserve paper.

5. Click Save to save your changes.
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How do I create and install a custom jurisidiction?

You can copy the data set for a previously installed jurisdiction to create a custom jurisdictional data set. This may be
helpful when, for instance, a court with which you file changes requirements between updates of the program. By copying
the applicable jurisdiction data set and modifying it as necessary, you can prepare for the changes while still having
access to the originally provided data set for use with cases initiated before the changes become effective.

To do this:

1. From the Preferences menu, choose Jurisdiction Setup.

2. Click the Install Jurisdictions tab. A list of jurisdictions appears in the pane.

3. Choose the jurisdiction you want to copy from the list by clicking the Expand button ( ) beside the applicable
state listing, then clicking the Expand button beside the applicable district listing, and, where needed, selecting the
district.

4. If necessary, install the official jurisdiction by selecting it and clicking Save.

5. Click the Copy As link next to the jurisdiction name you want to copy. The Create Custom Jurisdiction/Division
dialog box appears.

6. Enter a name for the custom jurisdiction in the New jurisdiction/division name box.

7. Click Create. The new jurisdiction is created and added to the list.

Note:

Once the jurisdiction is created, you may need to rename it. To do this, click the Rename link next to the
jurisdiction. With the existing name highlighted, type the new name and then click away from the name.

To remove a custom jurisdiction, locate the jurisdiction in the list and click the Delete link next to it. If it has
been specified for any cases you've created, you are prompted to confirm your action. Click Yes to confirm the
removal. (See How do I remove a jurisdiction? for more information about deleting jurisdictions.)

Tip:
You can customize the list of forms available for this jurisdiction, as well as customize the eFiling preferences for it.
Finally, you can refine exemption law sets for the jurisdiction.
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How do I remove a jurisdiction?

At times, you may want to remove a jurisdiction from Collier TopForm™ & File. When you uninstall a jurisdiction, any
associations between the jurisdiction and cases are removed, which means you must assign a new jurisdiction to the
case.

To do this:

1. From the Preferences menu, choose Jurisdiction Setup.

2. Click the Install Jurisdictions tab. A list of jurisdictions appears in the pane.

3. Choose the jurisdiction you want to remove from the list by clicking the Expand button ( ) beside the applicable
state listing, then clicking the Expand icon beside the applicable district listing, and, finally, clearing the selected
district.
Once you clear the jurisdiction, if it has been specified for any cases you've created, you are prompted to confirm
your action.

4. Click Yes to confirm the removal.

5. Click Save to save your changes.
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How do I add a firm?

The nature of organizations that prepare bankruptcy filings can be as varied as the filings themselves. For instance, some
organizations may consist of a single attorney, whereas other organizations may have multiple employees on staff. In yet
other settings, a paralegal may prepare bankruptcy filings for multiple firms.

To address variations in practice setup, Collier TopForm™ & File provides for refinement of organizational information,
allowing you to store name, contact, and professional information for multiple firms and staff members. Should a
representative leave your firm or should you cease preparing filings for a firm, you can subsequently delete the
corresponding firm.

To add a new firm:

1. Click the Preferences menu. The view changes to show the options for changing program preferences.

2. Click Firm Setup. The pane updates to include tabs showing specific firms with which you work.

3. Click the Add New tab.

4. Complete the information on the form and click Save. The firm information is saved and a section for adding a firm
representative is added to the form.

5. Enter the representative information and click Save.

6. Repeat this process for each new firm you want to add.
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How do I add a representative to a firm?

To address variations in practice setup, Collier TopForm™ & File provides for refinement of organizational information,
allowing you to store name, contact, and professional information for multiple firms and staff members.

To add representatives to a firm:

1. From the Preferences menu, choose Firm Setup. The pane changes to show the firms you have created.

2. Click the tab for the firm you want to add a representative to.

3. If necessary, enter or change the Firm Information.

4. In the Representatives section of the pane, enter the required information about the representative.

5. Click Save.

Note:

Click the Expand and Collapse buttons (  and ) to hide and show multiple representatives.
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How do I remove a representative from a firm?

Should a representative leave your firm or cease preparing filings for a firm, you can subsequently delete the
corresponding information from the repository of organizational data. When you remove a representative, it will be
removed from any cases that are associated with it. You must then manually choose a different representative for the
case.

To delete a representative from a firm:

1. From the Preferences menu, choose Firm Setup. The pane changes to show the firms you have created.

2. Click the tab for the firm from which you want to remove a representative.

3. In the Representatives list, locate the representative you want to delete.

4. Click the Delete button ( ) for the representative. A message appears, confirming that you want to complete the
action.

5. Click Yes. The representative is removed from the firm's information.

Note:

Click the Expand and Collapse buttons (  and ) to show and hide the representatives.
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How do I remove a firm?

To address variations in practice setup, Collier TopForm™ & File provides for refinement of organizational information,
allowing you to store name, contact, and professional information for multiple firms and staff members. Likewise, should
a representative leave your firm or should you cease preparing filings for a firm, you can subsequently delete the
corresponding information from the repository of organizational data.

Caution:
If you remove a firm, any representatives associated with the firm will likewise be removed. Additionally, any cases
associated with the firm (and its representatives) will need to be associated with a new firm (and representative).

To delete a firm from the Firm Setup:

1. From the Preferences menu, choose Firm Setup. The pane changes to show the firms you have created.

2. Click the tab for the firm you want to remove.

3. Click the Delete button ( ) on the tab. A message appears, confirming that you want to remove the firm from the
Firm Setup.

4. Click Yes. The firm is removed from the Firm Setup tab of Preferences.
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How do I refine exemption law sets?

To ease the process of applying exemptions to your cases, Collier TopForm™ & File comes complete with a repository of
exemption law information, which can be modified in order to reflect changes made by congress or your state legislature
between updates of the program. You can add, edit, or remove exemption laws on a jurisdictional basis.

To do this:

1. From the Preferences menu, choose Exemptions Setup. The page changes to show the settings for exemptions.

2. Choose the jurisdiction for which you want to modify exemption law information from the Jurisdiction drop-down list.

3. Choose the exemption laws you want to view from the Exemption laws drop-down list.

4. In the entry table, modify the data set as desired:

To edit the Description, Law, Exemption Amt., or Maximum Amt., click in the desired area and enter your
changes.

To add an exemption, enter it in the last row of the table.

To delete an exemption, click the row you want to delete and click the Delete link. Then click OK in the
confirmation window, asking whether you want to delete the item.

5. To save your selection, click Save.
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How do I create a master address list?

Collier TopForm™ & File lets you create lists of contact information for parties likely to be common across multiple claims
or cases. You typically populate these contact lists as part of completing the schedules and forms for your cases. You can
use the Master Address List to store contact information.

To create a master address list:

1. From the Preferences menu, choose Master Addresses. The pane changes to show the Master Address List.

2. In a blank address form, provide the information required.

3. Click Save to save your work.

Note:
To delete an address, click the  in the upper-right corner of the form. To collapse a list so you can just view the
name, click the Collapse button ( ).
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How do I prepare the case matrix and mailing labels?

The matrix refers to the list of creditor names and addresses that must be filed with the court. At one time, these were
prepared for copying on labels in a grid format, hence the term matrix. Most courts now use Optical Character Recognition
(OCR) equipment to import the data and require a single column list.

Additionally, you can print the list of creditors onto mailing labels for correspondence you may have for the case.

To create a matrix / mailing label list:

1. From the Preferences menu, choose Matrix/Mailings. The pane changes to show the different matrix/mailing label
options.

2. Click either the Matrix tab or the Mailing Labels tab. The appropriate pane appears with the last jurisdiction you
specified selected in the Jurisdiction drop-down list. (Select a different jurisdiction, if necessary.)

3. Specify related parameters, using the following information:

From the Label format drop-down list, choose the format of the labels that you will use for the matrix/mailing
label.

From the Max. characters per line drop-down list, choose the maximum number of characters allowed per line
in matrix/mailing label entries.

If the BANCAP option is selected, from the Labels down drop-down list, choose the number of labels running
down the length of a sheet.

If the BANCAP option is not selected, from the Order drop-down list, select whether the matrix/mailing label
entries should be listed in Vertical or Horizontal order.

Select All CAPS if your jurisdiction requires names and addresses to be printed in all capital letters and without
punctuation.

Select Remove duplicates if you want the program to automatically remove duplicate creditor listings.

Select Include account number if your jurisdiction requires that account numbers appear on the matrix/
mailing label.

Select Start creditors on new page to start the list of creditors on a new page.

If the BANCAP option is selected, select Blank lines between labels and indicate the number of blank lines
you want between each label if you want extra space between each label.

Select Debtor / Joint-Debtor / Attorney / Trustee in the Include group to include each of these entities on the
matrix/mailing label.

Select Schedule D / Schedule E / Schedule F / Schedule G to include creditors listed in each of these
schedules on the matrix/mailing label and in the creditor.txt file (which is used when efiling).

Select Include co-debtors if you want co-debtors listed in Schedule H to appear on the matrix/mailing label
and in creditor.txt.

Select Additional names to include a list of names that are to be included on all matrices for the given
jurisdiction and are not gathered elsewhere, such as names for the trustee or IRS.

Select Equity security holders to include equity security holder information.

4. Click Save to save your changes.
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How do I manage jurisdictional form sets and case associations?

In certain instances, you may find that a form included as part of the form set for one jurisdiction is useful for filings in
another jurisdiction in which the form is not officially required but is deemed otherwise acceptable by that court. In other
instances, a jurisdiction may cease requiring a particular form or may change the chapters or debtor type for which a
particular form is required. Collier TopForm™ & File lets you modify jurisdictional form sets and case associations to
address such scenarios.

Caution:
When modifying jurisdictional form sets, it is your responsibility to ensure that the changes are deemed acceptable by
the court in question.

To manage form sets:

1. From the Preferences menu, choose Forms.

2. Choose the jurisdiction whose forms you want you view from the Jurisdiction drop-down list. The list of forms on
the right side is updated to show the forms available for that jurisdiction.

3. Click the Initial Filing type drop-down list to specify the location to which you want to copy forms. Your options
include Emergency Forms, Initial Filing Forms, Jurisdictional Forms, and Other Bankruptcy Forms.

Note:
To create your own form category, click the Edit link. At the Form Categories dialog box, click the last row in the
table and enter the new category name. To remove a custom category, select it and click the Delete link. Click
Close to save your changes and close the dialog box.

4. In the All available forms list, browse to and select the form you want to include in the form list for the jurisdiction
you selected previously.

5.
Click the Add Form button ( ) to add the form to the list.

6. Complete any of the following optional steps:

To move a form to a different location in the list, select it and click the Move Up button ( ) or Move Down
button ( ). The form is moved to the new location.

To remove a form from the list, select it and click the Remove link. The form is removed from the list.

7. In the Display options for selected form section, select any of the following options:

To make sure the forms are available for a specific type of debtor, select the appropriate options from the
Debtor type group.

To make sure the forms are available for a specific type of filing, select the appropriate chapter from the
Chapter group.

To make sure the forms are available based on the nature of the debt, select the appropriate option from the
Nature of debt group.

Once you make these changes, each new case you create will have access to the forms you specified for each
jurisdiction.

Note:

By default, if at a later time you print or e-file the group of forms in this list, they will be grouped together in
a single PDF file. If you want to separate the documents into smaller subgroups, you can insert file breaks,
which indicate the first and last form included in each PDF file. To add a file break, select the last form you want
included in the group of documents and click Insert file break. If you need to move the file break, select it and

click the Move Up button ( ) or the Move Down button ( ). To remove a file break, select it and click Delete
file break.
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To restore the system preferences for the selected jurisdiction, click Reset to program default. Any changes
you've made to the forms list will be removed.
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How do I specify e-filing preferences?

You can specify default properties associated with electronic filing. These properties will be suggested when you start the
electronic filing process for individual cases you are working on.

To do this:

1. From the Preferences menu, choose eFiling. The pane changes to show eFiling preferences.

2. Provide the following information:

Click Jurisdiction to specify the jurisdiction whose settings you want to modify.

In the Court ECF login URL field, enter the dedicated Internet address for filing electronically with your court.

In the ID field, enter the ID provided by the court for purposes of electronic filing.

In the Password field, enter the password corresponding to your ECF ID, and then re-enter it again in the Re-
enter password field.

In the Signature code field, enter the code that will be used for all e-signatures.

Select Acknowledge and accept compliance responsibility with redaction requirements to indicate that
you understand the redaction requirements associated with filing.

3. Click Save to save your changes.
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How do I change the filing fees associated with the cases I file?

At times, you may need to update the filing fee amount required to file cases within the court. For example, if the court
changes its fees between releases of Collier TopForm™ & File, you can update the amounts within the program so that
the data you are using is current.

To do this:

1. From the Preferences menu, choose Filing Fees. The pane changes to show the different amounts for filing each
type of plan. Text above the fee table indicates the effective date of the existing fees.

2. Enter the new fee amount for the type of filing you want to update.

3. Click Save to save your changes.

Note:
You can click Reset to last court-defined amounts to restore the fees to match what was available at the effective
date.
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Creating and Working with Bankruptcy Cases

How do I create a new bankruptcy case?

Starting a new bankruptcy case involves choosing a filing type, validating case settings, providing background information,
and then generating the documents necessary to submit the filing. Collier TopForm™ & File lets you create Chapter 7, 11,
12, and 13 filings.

To create a new case:

1. At the Collier TopForm™ & File window, click Start New Case, located in one of the following places:

File menu

Empty case page (Case menu)

Dashboard page

The window changes to show a form where you can provide the case information.

2. Review the fields on the form and make any necessary changes by either typing directly in the field or selecting from
the corresponding drop-down list or group of related options, as applicable.

3. Once the information has been entered, click Create Case. You are taken to the Case tab, with the Home tab
showing.

4. Enter the information about the debtor.

5. Complete the forms necessary for your client's case.
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About Importing Collier TopForm™ Bankruptcy 10.5.x Cases

If you are migrating from using Collier TopForm™ Bankruptcy Filing Program version 10.5.x, the first thing you'll notice is
that this new version of Collier TopForm™ & File is completely new, both in appearance and in functionality. A lot of effort
has been made to improve the program and streamline the process of completing a case from start to finish.

One of the major changes was to improve the way firm and client data flows between the program itself and the forms you
must complete to file a case. With these new changes, you should only need to enter data once, and as you complete
other forms, fields requiring the same information should automatically have this information filled in. This answer flow-
through greatly decreases the time spent completing all of the required forms, schedules, and ancillary documents
required as part of the filing process.

Collier TopForm & File 13 includes a tool to import settings and cases from Collier TopForm Bankruptcy 10.5. Every effort
has been made to ensure that the tool imports and maps the data coming from version 10.5 to data used in version 13.
However, not all data was able to be mapped correctly. For example, in Collier TopForm Bankruptcy 10.5, addresses
(including street, city, state, and zip) were saved as one "chunk" of text. However, in Collier TopForm & File 13, addresses
are saved as distinct pieces of data (e.g., street is one answer, city is another answer, and so forth). Because of this
discrepancy between the two versions of the product, we were unable to map the single chunk of data coming from
version 10.5 to its individual parts in version 13. Instead, the full address coming from version 10.5 is mapped to just the
street address in version 13.

Because of these discrepancies, if you choose to import your cases from Collier TopForm Bankruptcy 10.5, you must
review each of the forms and correct any data that was imported incorrectly. To help you identify which forms need to be
reviewed after you've imported your cases, Collier TopForm & File creates a log file which lists these forms, along with the
data that needs to be checked. You can find this log file in the Logs subfolder of the Collier TopForm & File program folder
(for example, C:\Users\YourUserName\Documents\LexisNexis\TopForm\Logs).

Other Things to Note After You Import Your Cases

When importing the data for Form 7, Collier TopForm & File may not be able to distinguish between debtor and
co-debtor information. As such, you should review Form 7 for each case you imported and make corrections, if
necessary.

Once you have reviewed cases listed in the log file, you must review the data in each schedule. This step is required
if you plan to electronically file or print these forms later. To view the schedules, open the case (either at the File
menu or at the Dashboard menu), and then view the schedules at the Forms subtab.

Additional data you may want to review includes phone numbers, dates, and social security numbers, all of which
may not be formatted properly, as well as exemption laws, which may not have matching statute titles in version 13.

Please see How do I import cases from Collier TopForm 10.5? for instructions on importing your cases.
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How do I import cases from Collier TopForm 10.5?
Caution:

Before importing your existing cases into Collier TopForm™ & File, please review the help topic About Importing
Collier TopForm™ Bankruptcy 10.5.x Cases.

Only those preferences and cases you worked with using Collier TopForm 10.5 and later will be available to be
imported.

When you first upgrade from Collier TopForm Bankruptcy 10.5 and then launch Collier TopForm & File after installing it,
you are prompted to import your preferences (such as firm and attorney information, as well as your master address list).
You are also prompted to import those most recent cases you have worked on. You can import your data this first time
you launch the product, or you can import it at a later time.

To import Collier TopForm Bankruptcy 10.5 cases into the current version of Collier TopForm & File:

1. To start the import process, complete one of the following steps:

If you are importing cases as the final step in the installation process and you are already viewing the Import
Data dialog box, skip to Step 2.

If you are importing cases separate from the installation, choose Import Data from the Collier TopForm & File
File menu. Then choose Collier TopForm(TM) Bankruptcy 10.5 from the Import data from drop-down list.

2. Select the preferences you want to import in the Preferences section.

3. Select the cases you want to import in the Cases section.

4. Click Import.
If Collier TopForm & File experiences problems while importing the data, it displays a message at the end of the
process, indicating that it created a log file. This file lists the data that was either not imported, or it lists data that
you'll need to review because data from Collier TopForm Bankruptcy 10.5 could not be mapped properly to fields in
Collier TopForm & File 13. This log file is typically stored in the Logs subfolder of the Collier TopForm & File program
folder (for example, C:\Users\YourUserName\Documents\LexisNexis\TopForm\Logs).

5. If necessary, review the log file and make the necessary data corrections in the listed forms.
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How do I import cases from other bankruptcy filing programs?

You can import case data from other bankruptcy products, such as Bankruptcy, Best Case Bankruptcy, or EZ Filing. The
data you are importing must be in a format Collier TopForm™ & File recognizes, including comma-separated or tab-
separated.

To import cases from other bankruptcy filing programs into the current version of Collier TopForm & File:

1. Choose Import Data from the Collier TopForm & File File menu.

2. Choose the program you've been using from the Import data from drop-down list.

3. Click the Browse button next to the Data file name box to locate and select the data file you want to import.

4. Optionally, select Do not import duplicate data to keep Collier TopForm & File from importing duplicate data.

5. Click Import.
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How do I import Collier TopForm™ & File cases from other users?

You can import a case file or multiple case files that have been exported from another computer on which Collier
TopForm™ & File is running. This way, you can share copies of individual case files or groups of case files between users
using Collier TopForm & File on different computers.

Caution:
Case importing/exporting does not support concurrent access to the same individual case files by multiple users on
different machines, nor will it reconcile or merge changes made separately by users to copies of a case with the same
file name. When importing, you will have the option to either override (replace) one of the copies using the same file
name, or rename one of the case files with a different file name to retain changes made to both copies.

To import a case:

1. At the Collier TopForm & File window, click the File menu.

2. Choose Import Data from the list of options on the left.

3. Choose TopForm Cases from the Import data from drop-down list.

4. Click Browse next to the Data file name box, and then browse to and select the cases you want to import. (Once
the files are selected, click Open to return to the TopForm Import window.)

5. In the list of cases to import, select the cases you want and click Import. The Import Case dialog box appears,
providing options for how you want to import the case.

6. Choose the option you prefer:

Tip:
To perform the same action on all cases you are trying to import, select Do this for X conflicts and then select
your option.

Import and Replace: Replaces the existing case (local copy of the case) with the one you're trying to import.

Don't Import: Leaves the existing, local copy of the case as it is and cancels the import process for the
specified case.

Import but Keep Both Cases: Lets you keep your existing, local copy of the case and import the new case by
assigning a new name to it.

Note:
If you selected the option to import the case but keep the original, you probably want to rename the imported file to
something meaningful. See How do I rename a case? for instructions on doing this.
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How do I export Collier TopForm™ & File cases for users on other computers?

You can export a case file or multiple case files to be used on another computer on which Collier TopForm™ & File is
running. Once you export a case, you will still be able to edit and work with the original case.

When cases are exported from Collier TopForm & File, the exported cases will include all of the data for the case except
application preference settings, such as e-filing settings, forms preferences, exemptions and matrix/mailing label format
settings.

Caution:
Case importing/exporting does not support concurrent access to the same individual case files by multiple users on
different machines, nor will it reconcile or merge changes made separately by users to copies of a case with the same
file name. When importing, you will have the option to either override (replace) one of the copies using the same file
name, or rename one of the case files with a different file name to retain changes made to both copies.

To export a case:

1. At the Collier TopForm & File window, click the Dashboard menu.

2. In the Cases list, select the cases you want to export.

3. Click Export. A progress bar appears.

4. When prompted to enter a file name for the collection of exported cases, specify the location and name you want
assigned and click Save. If the export was successful, you see a confirmation message.

5. Click OK.

When a case or group of cases is exported, it will be marked with this icon: . This icon will be visible until a case with
the same file name has been re-imported. Additionally, the case status for an exported case will automatically change
to "exported" and an "Important Date" entry indicating the date and time of export will automatically be added to the
Important Dates field for the case.

See How do I import Collier TopForm™ & File cases from other users? for instructions on importing a case.
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How do I rename a case?

At times, you may need to rename one of your cases.

To do this:

1. Open the case you want to rename.

2. Click on the case name, near the top of the window. The text becomes editable.

3. Type the new name.

4. Click away from name field. Your changes are saved.
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How do I provide information about the debtor for a case?

Once you have validated case settings, you are ready to provide the necessary background information for the filing, such
as the debtor’s name and contact information and information on bankruptcy cases pending against the debtor.

Note:
If you complete the Debtor Information (Voluntary Petition), the answers you enter there will automatically be used
in this Debtor form. To access the Voluntary Petition, click the link at the bottom of the Debtor form, or click the
Forms tab and select to complete it there.

To enter background information about the debtor:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. In the Debtor section of the page, enter the required information, such as the debtor's name and address
information.

4. Click Save to save the information.

Note:

You can associate externally created documents with the case by adding them at the Case > Home tab. See
Associate documents with this case for information.

If the debtor has used any aliases, save the debtor information, click the Aliases link, and enter the appropriate
information.
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How do I use the different case wizards to pre-enter information?

When completing bankruptcy documents, a lot of information is repeated throughout the different documents. You can
either enter this information as you complete these documents, or you can provide it while completing the Debtor form.
Either way, the information will be available for each document or schedule that requires it.

Specific wizards you can complete include:

Voluntary Petition

Property & Exemptions (to be used for Schedules A, B, and C)

Creditor & Claims (to be used for Schedules D, E, and F)

To do this:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. In the Debtor section of the page, under Enter additional Debtor information, click the link for the wizard you want
to complete.

4. Complete the wizard.
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How do I add aliases for a debtor?

You can enter alias names for a debtor or joint debtor.

To do this:

1. Enter or edit information about the debtor or joint debtor. (Make sure you save the information after you are finished.)

2. At the Home tab of the case, in the Debtor section of the page, click the Aliases link. The Debtor Aliases dialog box
appears.

3. Choose whether the alias is for the debtor or joint debtor by choosing the correct option from the Debtor type drop-
down list.

4. Choose the type of alias you are assigning from the Alias type drop-down list.

5. Enter the required information in the fields.

6. Click Save to save your changes.

7. Click the Close icon ( ) to close the dialog box.
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How do I edit information about an existing case?

In certain situations, you may find it necessary to change case settings after you've created it. For example, you may need
to change the debtor type or nature of debt for a case. Collier TopForm™ & File allows for quick and easy modifications of
case settings once you've created a new case.

To edit case data:

1. Open the case you want to edit.

2. While viewing the case, complete any of the following optional steps:

To edit the case settings (for example, the chapter type or the type of exemption laws), change the setting in
the area along the top of the Case page.

To edit the debtor or co-debtor information, make the changes in the Debtor section of the page.
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How do I associate documents with a case?

Collier TopForm™ & File includes the many different forms you need to file with your bankruptcy case. There may be
times, however, when you need to associate additional documents with your case so they can be included in your filing.
For example, you may need to include a copy of your pay stubs or other documents required by your case.

The types of files you can add to a case include PDF documents, TXT files, and several types of images files, including
JPG, BMP, and TIFF.

When you add documents to the Documents list, copies of the document are saved to the case folder.

To do this:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. View the Documents section of the page.

4. Complete any of the following optional steps:

To add a document to the list, click Add, then locate and select the document you want to include. Click Open
to add it to the list.

To remove a document from the list, select the document in the list and click Delete. (The document is
removed from the case folder, but the copy in the original folder location isn't deleted.)

To sort the list of documents, click the column header (Name, Type, or Modified) on which you want to sort.

To open the folder where copies of the documents are stored, click the Open Case Folder button ( ).
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How do I add notes to a case?

As you work with different bankruptcy cases, you may want to make notes about the case. This can be useful if you want
to document certain actions or tasks you perform and have those notes associated with the case. You can use the Notes
tool within Collier TopForm™ & File to do this.

To include notes with a case you are working on:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. View the Notes section of the page.

4. Select the name of the person who is entering the notes from the Adding as drop-down list.

Note:
To add a name to the list, click Adding as, and then enter the names in the list. Click Close when you are done.

5. Enter your note in the text field, and then click Add Note. Your note is added to the list of notes below.

Note:
You can edit notes after you add them. You can also print, save, or delete notes. See How do I work with case notes?
for details.
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How do I work with case notes?

Once you add a note to a case, you can edit it, print it, save it as a separate file, or delete it.

To do any of these things:

1. Open the case you want to edit.

2. Complete any of the following steps:

Option Description

To download the case
notes and save them in a
separate file

Select the notes you want to download and click Download Notes. When prompted,
specify the location where you want to save the file. A PDF version of the notes are
saved in the location you specify.

To print a copy of the case
notes

Select the case notes you want to print and click Print Notes. The notes are printed.

To edit a case note Select the case you want to edit and click Edit. The Edit Case Note dialog box
appears. Make your changes and click Save.

To delete a case note Select the case you want to delete and click Delete.
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How do I record key dates and activities associated with the case?

You can keep a record of the important dates and activities associated with your debtor's case. As part of this, you can
assign a status to the activities.

To do this:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. Locate the Important Dates section of the page. The date you created the case appears in the top-left section of the
Important Dates tool.

4. Complete any of the following optional steps:

If you manually file the case, enter the filing date in the Date filed box. (If you eFile the case, that date is
automatically added to this box.)

View the number of days since the case was opened under the Age heading.

Add a new activity (and associated date) by clicking Add and completing the information on the Add Important
Date dialog box.

Edit an existing activity by clicking its link in the Activity column of the Important Dates table and making the
changes on the Modify Important Date dialog box.

Delete an activity by selecting the check box next to the activity in the table and clicking Delete.

Keep a record of an activity, but mark it as complete by changing the activity's status to Complete. The activity
is marked as such and a line is drawn through it to further help you understand that the task is finished.
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How do I assign a working status to a case?

Often you want to track your progress on a case as well as keep records of the case's filing status. Using the tools
available in Collier TopForm™ & File, you can follow your case from the moment you start it until it is resolved in the court
system. Additionally, if you aren't ready to start the case, you can mark it as prospective.

To do this:

1. Open the case you want to edit.

2. Click the Home tab. The view changes to show information about the debtor.

3. View the Status section of the page.

4. Choose the status you want assigned to the case from the Case status drop-down list. Your options include Active,
Closed, Prospect, and Exported.

5. Choose the associated filing status from the Filing status drop-down list. (Your options vary, depending on which
case status you selected in the previous step.)

Once you assign these statuses to your cases, the information can be viewable from any case listing, for example at the
Cases tab of the Dashboard.

case-openexistingcase_hdi.html
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How do I open an existing bankruptcy case?

While you are working on a bankruptcy case, you will often need to make ongoing changes to the details of the case.
For example, as you receive new information about your client, you may need to generate additional bankruptcy
documents. To do this, you can either open a case from the File menu, or you can access your most recent cases from
the Dashboard.

To open a case:

1. At the Collier TopForm & File window, choose one of the following options:

Choose View Cases from the File menu. The view changes to show all of the cases you are working on in the
right pane.

Click the Dashboard menu. The Dashboard page appears.

2. Click the link for the case you want to view. The case is opened.

Note:
If you don't immediately see the case you want to edit, use the search field above the case list to type some of
the text that appears in the case name. Cases matching your search terms appear. (Click the X in the search box
to clear your search.)

3. Begin working on the case or open another case, as desired.
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How do I select bankruptcy forms for completion?

Once you have created a bankruptcy case, you can generate the documents pertinent to the case. For example, you
can complete the Voluntary Petition, Schedules A-J, and the different forms required for the filing, just to name a few.
Information you provide as you complete these different documents will be used in each document that requires it. When
you're ready to file the case, the completed documents will be generated in PDF format so you can file them with the
court.

Collier TopForm™ & File uses the third-party application HotDocs Player™ to create the documents you need for your
bankruptcy cases. When you select a document for creation, the HotDocs Player window opens over the top of the
Collier TopForm & File window. You must complete your work in the HotDocs Player window before you can return to the
TopForm window.

To generate a document for your case:

1. Create a new bankruptcy case or open an existing case.

2. At the Case tab for the case you want to work on, click the Forms tab. The view changes to show the forms
associated with this kind of filing.

Tip:
Information about the case (such as the type of filing, jurisdiction, and case representative) appears at the top of
the page.

3. Locate the form you need to complete in the list.

Tip:
To locate a specific form in the list, enter your search term in the search box. As you type, the list of forms is
filtered to show only those forms that contain your phrase.

4. Double-click the form. A secondary window appears, displaying a series of dialogs that contain the questions
necessary for completing the form.

5. Complete the interview as described in Completing a Document.

6.
When you are finished, click the Finish button ( ) in the navigation toolbar to close the form window. Your data is
automatically saved, the form window is closed, and you are returned to the Forms tab.

7. Optionally, to track a form's completion status, right-click on the form and indicate whether work on the form is Not

Started ( ), In Progress ( ), or Completed ( ).

Note:
You can customize the forms that appear in the different forms lists. To do this, see Manage Jurisdictional Form Sets
and Case Associations.
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Completing a Document

Collier TopForm™ & File uses the third-party application HotDocs Player™ to create the documents you need for your
bankruptcy cases. When you select a document for creation, the HotDocs Player window opens over the top of the
TopForm window. You must complete your work in the HotDocs Player window before you can return to the TopForm
window.

The following features are available in the HotDocs Player window. This information can help you complete the interview
as you create the required documents.

Feature Description

Interview tab The Interview tab is divided into two panes. The left pane contains an outline of the
different groups of questions you must answer, while the right pane contains the
individual questions in those groups.

Interview outline icons Icons used in the interview outline indicate the answered status of questions in the dialog:

 indicates that no questions in the dialog have been answered

 indicates that some questions in the dialog have been answered

 indicates that all questions in the dialog have been answered

Additionally, some icons indicate that the questions contained in the dialog can be used
to create a list of answers:

 indicates that questions in the dialog will be repeated so you can enter more than
one set of answers

Dialog navigation icons Each dialog contains a row of navigational buttons to help you move through the
interview questions:

 and  take you to the first and last dialogs in the interview

 and  take you to the previous and next dialogs in the interview that contain
unanswered questions

 and  take you sequentially through the interview, dialog by dialog

 finishes the interview, saves the answers in an answer file and returns you to
the TopForm window

Document tab You can click this tab to preview how the completed document looks.

Note:
The actual name of this tab changes, based on whether the document is PDF-based
(Form Document) or word processor-based (Document Preview).

Question Summary and
Answer Summary tabs

These tabs provide snapshots of the questions (and answers) required to complete
the document. The Question Summary tab lists just the questions, while the Answer
Summary tab shows the questions along with any answers you have provided.
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Practice Pointers
When you see this icon  next to a question in a dialog, you may click it and view
additional commentary about the question. Additionally, commentary may be available for
the entire group of questions. This is indicated by the resource icon in the dialog title bar.

Answering questions
repeatedly to create a list of
answers

Some dialogs in a form interview are designed to let you enter more than one set of
answers. These dialogs can appear in one of two ways:

Repeated as a series: Series dialogs include the following button: . Click this

button to add another series of answers. When you are finished, click the Next ( )
button to move to the next dialog in the interview.

Repeated as a spreadsheet: Spreadsheet dialogs appear using a table. You enter
your sets of answers on each row. You can use the buttons along the bottom of
the table to edit existing answers, add a new set of answers, or remove a set of
answers.

End of Interview dialog The last dialog in a series of interview questions is called the End of Interview dialog. It
provides information about the number of questions you may have left unanswered. (If
you have left questions unanswered, use the icon hints in the interview outline on the left
to locate which dialogs still require information, and provide the answers.) To return to

the TopForm window, close the HotDocs Player window by clicking Finish ( ) in the
navigation bar.



Collier TopForm® & File User Guide

51

How do I accommodate Social Security Number requirements?

Rule 1005 stipulates that in addition to any taxpayer identification number, the debtor may list only the last four digits of
his or her Social Security number in the caption of the bankruptcy petition. At the same time, courts generally require that
the debtor’s complete Social Security number be provided as part of any filing. Collier TopForm™ & File uses Official
Form 21 (Statement of Social Security Number) for purposes of providing the debtor’s complete Social Security number in
a manner pursuant to Rule 1005 for Chapter 7, 11, 12, and 13 cases.

To complete Form 21:

1. Open the case for the client who needs to complete Form 21.

2. At the Case tab, click the Forms tab. The list of forms appears.

3. In the Initial Filing Forms group, locate and double-click Form 21 - Statement of Social Security Numbers. The
interview questions for the form appear.

Note:
To quickly find the form in the list, type a portion of the form name in the search field above the forms list.

4. Complete the interview.
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How do I print case documents?

Collier TopForm™ & File provides flexibility in printing documents. If you want to print an amended version of a document,
print multiple documents within a single printing session, or adjust printer settings before printing documents, you can do
so. Additionally, before printing documents, you may want to preview them.

To print case documents:

1. At the Case tab, click the Print subtab. The view changes to show printing options.

2. From the drop-down list at the top of the Print pane, choose either Initial Filing, Emergency Forms, Other
Bankruptcy Forms, or Jurisdictional Forms, as applicable. A list of documents for the chosen category is
displayed in the pane below.

3. Select the desired schedules and forms you want to print. (To keep a form from being printed, clear the associated
check box.)

Note:
To select all documents in the list, select the check box next to Documents to print. To clear the selection of all
existing documents, clear this same check box.

4. Verify the form order. (To move a form up or down in the list, select it and click the Move Up or Move Down button

(  and ).)

5. Make the following optional selections:

Select Print amended titles indicate whether the program should print amended titles on schedules and
forms.

Select Print only amended records to indicate whether the program should print only those records that have
been amended.

6. Optionally, to preview the selected documents before printing them, click Preview. The selected documents are
opened in your PDF viewer so you can examine them. If you'd like, you can use the PDF viewer's Print functionality
to continue printing the documents, or you can close the preview and click the Print button, as described in the next
step.

7. Once you have verified all of your printing settings, click Print.

Note:
To set the Documents to Print list back to its default state, click Reset.
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About Case Matrices

A case matrix refers to the list of creditor names and addresses that must be filed with the court. The court will then use
this list to notify the debtor's creditors of the bankruptcy filing as well as provide notice to them of the meeting of creditors.
By using Collier TopForm™ & File, you can specify how the matrix is set up as well as define what information should be
included in it. Rules for formatting and delivering the matrix vary slightly between jurisdictions.

Tip:
At one time, matrices were prepared for copying on labels in a grid format, hence the term matrix. Most courts now use
Optical Character Recognition (OCR) equipment for importing the data. As such, matrices can be submitted in a single
column list.
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About the Bankruptcy Means Test

Under the Bankruptcy Abuse Prevention and Consumer Protection Act of 2005 (P.L. 109-8), a consumer bankruptcy
petitioner's current income and expenses may create a presumption of abuse. The Means Test is the calculation used
to determine whether or not the presumption of abuse arises. The calculation incorporates regional median income
information from the Census Bureau and various deductions based on national and local Internal Revenue Service
standards. If the presumption of abuse arises and cannot be overcome by special circumstances, the debtor is not entitled
to file under Chapter 7, and would instead have to file under another chapter, typically Chapter 13. Chapter 13 uses the
same deductions and calculations to determine disposable income.

Included with Collier TopForm™ & File is a repository of data from the Internal Revenue Service (IRS) and the U.S.
Census Bureau for use in performing the calculations necessary to file Chapter 7 and Chapter 13 bankruptcies, including
means testing to determine whether a case qualifies for Chapter 7.

Collier TopForm & File includes both Form 22A - Statement of Current Monthly Income and Form 22C - Chapter 13
Statement of Currently Monthly Income and Calculation of Commitment Period and Disposable Income, which are
used to complete the Means Test. Although Form 22C, for Chapter 13 bankruptcies, does not refer to means testing, it
uses the same questions, calculations, and deductions as the B22A Means Test to determine disposable income.
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Generating the Necessary Bankruptcy Forms

How do I select bankruptcy forms for completion?

Once you have created a bankruptcy case, you can generate the documents pertinent to the case. For example, you
can complete the Voluntary Petition, Schedules A-J, and the different forms required for the filing, just to name a few.
Information you provide as you complete these different documents will be used in each document that requires it. When
you're ready to file the case, the completed documents will be generated in PDF format so you can file them with the
court.

Collier TopForm™ & File uses the third-party application HotDocs Player™ to create the documents you need for your
bankruptcy cases. When you select a document for creation, the HotDocs Player window opens over the top of the
Collier TopForm & File window. You must complete your work in the HotDocs Player window before you can return to the
TopForm window.

To generate a document for your case:

1. Create a new bankruptcy case or open an existing case.

2. At the Case tab for the case you want to work on, click the Forms tab. The view changes to show the forms
associated with this kind of filing.

Tip:
Information about the case (such as the type of filing, jurisdiction, and case representative) appears at the top of
the page.

3. Locate the form you need to complete in the list.

Tip:
To locate a specific form in the list, enter your search term in the search box. As you type, the list of forms is
filtered to show only those forms that contain your phrase.

4. Double-click the form. A secondary window appears, displaying a series of dialogs that contain the questions
necessary for completing the form.

5. Complete the interview as described in Completing a Document.

6.
When you are finished, click the Finish button ( ) in the navigation toolbar to close the form window. Your data is
automatically saved, the form window is closed, and you are returned to the Forms tab.

7. Optionally, to track a form's completion status, right-click on the form and indicate whether work on the form is Not

Started ( ), In Progress ( ), or Completed ( ).

Note:
You can customize the forms that appear in the different forms lists. To do this, see Manage Jurisdictional Form Sets
and Case Associations.
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Completing a Document

Collier TopForm™ & File uses the third-party application HotDocs Player™ to create the documents you need for your
bankruptcy cases. When you select a document for creation, the HotDocs Player window opens over the top of the
TopForm window. You must complete your work in the HotDocs Player window before you can return to the TopForm
window.

The following features are available in the HotDocs Player window. This information can help you complete the interview
as you create the required documents.

Feature Description

Interview tab The Interview tab is divided into two panes. The left pane contains an outline of the
different groups of questions you must answer, while the right pane contains the
individual questions in those groups.

Interview outline icons Icons used in the interview outline indicate the answered status of questions in the dialog:

 indicates that no questions in the dialog have been answered

 indicates that some questions in the dialog have been answered

 indicates that all questions in the dialog have been answered

Additionally, some icons indicate that the questions contained in the dialog can be used
to create a list of answers:

 indicates that questions in the dialog will be repeated so you can enter more than
one set of answers

Dialog navigation icons Each dialog contains a row of navigational buttons to help you move through the
interview questions:

 and  take you to the first and last dialogs in the interview

 and  take you to the previous and next dialogs in the interview that contain
unanswered questions

 and  take you sequentially through the interview, dialog by dialog

 finishes the interview, saves the answers in an answer file and returns you to
the TopForm window

Document tab You can click this tab to preview how the completed document looks.

Note:
The actual name of this tab changes, based on whether the document is PDF-based
(Form Document) or word processor-based (Document Preview).

Question Summary and
Answer Summary tabs

These tabs provide snapshots of the questions (and answers) required to complete
the document. The Question Summary tab lists just the questions, while the Answer
Summary tab shows the questions along with any answers you have provided.
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Practice Pointers
When you see this icon  next to a question in a dialog, you may click it and view
additional commentary about the question. Additionally, commentary may be available for
the entire group of questions. This is indicated by the resource icon in the dialog title bar.

Answering questions
repeatedly to create a list of
answers

Some dialogs in a form interview are designed to let you enter more than one set of
answers. These dialogs can appear in one of two ways:

Repeated as a series: Series dialogs include the following button: . Click this

button to add another series of answers. When you are finished, click the Next ( )
button to move to the next dialog in the interview.

Repeated as a spreadsheet: Spreadsheet dialogs appear using a table. You enter
your sets of answers on each row. You can use the buttons along the bottom of
the table to edit existing answers, add a new set of answers, or remove a set of
answers.

End of Interview dialog The last dialog in a series of interview questions is called the End of Interview dialog. It
provides information about the number of questions you may have left unanswered. (If
you have left questions unanswered, use the icon hints in the interview outline on the left
to locate which dialogs still require information, and provide the answers.) To return to

the TopForm window, close the HotDocs Player window by clicking Finish ( ) in the
navigation bar.
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Initial Filing Documents

The following table describes some of the different schedules and forms you may be required to complete for your
bankruptcy filing:

Note:

When you complete the various forms required by your bankruptcy filing, some of the forms may include
guidance to help you understand what's required by the form. This material usually appears as the first dialog (or
page) during the form interview question process, and it's titled something like "<< Form 1 Guidance >>". This
content is provided by LexisNexis experts on the bankruptcy process.

See Additional Documents for a list of other required forms.

Schedule Name Description

Schedule A: Real Property Real property refers to items such as houses, cabins, and land. All of the debtor’s
interests in real property except leasehold interests listed on Schedule G must be listed
on Schedule A.

Schedule B: Personal
Property

Personal property refers to items such as automobiles, boats, and clothing. All personal
property of the debtor must be listed in Schedule B.

Schedule C: Property
Claimed as Exempt

Schedule C summarizes the exemption status of the debtor’s real and personal property.
Information you enter while completing Schedule A and B automatically flows to and is
displayed in Schedule C so that you can review and validate that you have taken the
proper exemptions. Should you need to edit exemption assignments, you can do so
directly in Schedule C.

Schedule D: Creditors
Holding Secured Claims

Schedule D details claims for which there is an outstanding past-due amount. All
creditors holding secured claims against property of the debtor must be listed in Schedule
D.

This information is transferred to the Chapter 7 Statement of Intention Regarding
Secured Debts form. Information about the choices available in completing this form is
available in Collier Consumer Bankruptcy Practice Guide ¶6.12.

The program feeds this information to Schedule H, where co-debtors on any debts of the
debtor must be listed. Schedule H is discussed further in Collier Consumer Bankruptcy
Practice Guide ¶6.07[4].

Schedule E: Creditors
Holding Unsecured Priority
Claims

Schedule E details creditors whose claims are unsecured. All creditors holding unsecured
priority claims against the debtor must be listed in Schedule E.

Detailed information about completing Schedule E is available in Collier Consumer
Bankruptcy Practice Guide ¶6.07[2][b].

Schedule F: Creditors
Holding Unsecured
Nonpriority Claims

Schedule F details creditors whose claims are unsecured. All creditors holding unsecured
nonpriority claims against the debtor must be listed in Schedule F.

Schedule G: Executory
Contracts and Unexpired
Leases

Schedule G details executory contracts and unexpired leases and indicates whether
they will be rejected or assumed and, possibly, additional information depending on
jurisdiction. All executory contracts and unexpired leases of the debtor must be listed in
Schedule G.

Schedule H: CoDebtors Schedule H summarizes information related to co-debtors. Information entered while
completing Schedules D, E, and F automatically flows to and is displayed in Schedule H
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for purposes of your review and validation. Should you need to add or refine co-debtor
assignments to claims, you can do so directly in Schedule H.

Schedule I: Current Income
of Individual Debtors

Schedule I details income of the debtors, and the income of all debtors must be listed in
Schedule I. The schedule primarily requires numeric data related to the debtor and the
debtor’s spouse, if any.

Schedule J: Current
Expenditure of Individual
Debtors

Schedule J details expenses of the debtors and, when applicable, of the debtor’s spouse,
debtor’s business, and debtor’s spouse’s business. All of the debtor’s current expenses
must be listed in Schedule J.

Summary of Schedules The Summary of Schedules outlines important details about your case, including the
following:

The schedules you have selected to include in your filing

The number of pages that will print for each schedule

Note:
Until the entire case is complete, the total page count may not be accurate.

Reviewing the Summary of Schedules is an important step in preparing an initial filing.

Form 7: Statement of
Financial Affairs

Form 7 must be filed in every case. The document contains 25 questions and
subquestions that appear numbered as they are on the official form.

Form 8: Chapter 7
Individual Debtor’s
Statement of Intention

The debtor must complete the Form 8 — Statement of Intention for each property that is
collateral for a secured debt. The information on Form 8 flows from Schedules D, E, F,
and G. If upon reviewing the information reflected in Form 8 you discover any mistakes,
you can post corrections here. When you do so, the program automatically updates the
corresponding schedule accordingly.

Form 22: Statement of
Current Monthly Income
[and Means Test or
Disposable Income
Calculation]

Form 22 must be completed for certain individual debtors filing Chapter 7, for individual
debtors filing Chapter 11, and for all debtors filing Chapter 13. The questions included
in Form 22 vary depending on chapter type: Chapter 7 and 13 cases contain questions
corresponding to the categories of information used in determining current monthly
income and calculating the Means Test (for Chapter 7 cases) or determining Disposable
Income (for Chapter 13 cases), and Chapter 11 cases contain questions for the gathering
of current monthly income data.

Form 23: Debtor’s
Certification of Completion
of Instructional Course
Concerning Personal
Financial Management

In all cases, Form 23 must be filed in order to alert the clerk that the debtor has satisfied
the requirement of completing an instructional course in personal financial management.

Form 24: Certification to
Court of Appeals by all
Parties

Form 24 must accompany appeals, bankruptcy court judgments, orders, or decrees
directly to the United States Court of Appeals.
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Additional Documents

Based on certain case variables, additional information and documents may be required for a filing. For instance, filings
for publicly traded corporations and partnerships must include details on stock as well as other financials. In such
instances, this information constitutes the basis for documents in addition to those that would otherwise be prepared for
an initial filing.

Other types of bankruptcy forms are grouped in the following categories, by default:

Emergency Forms: Emergency filings require documents that would otherwise be prepared for an initial filing
as well as additional documents. As an aid in preparing emergency filings as quickly as possible, the program
separately categorizes the necessary forms, displaying them together under the Emergency Forms folder in the
Forms list.

Other Bankruptcy Forms: Certain forms that apply to only certain types of cases may not be required as part of the
initial filing. These types of forms are typically listed in the Other Bankruptcy Forms folder.

Jurisdictional Forms: Some forms are required and provided by the jurisdiction in which you are filing. These forms
are available in this list.
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How do I complete Schedule A: Real Property?

Real property refers to items such as houses, cabins, and land. All of the debtor’s interests in real property except
leasehold interests listed on Schedule G must be listed on Schedule A.

To complete Schedule A:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule A - Real Property.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Form 6A in the Form 6A Guidance dialog, which is the first dialog in the interview.

5. Review and enter information in the Case Information dialog. Specifically, if the debtor has real property, select The
debtor has real property.

6. Review and provide all requested information within the Real Property dialog, using the following information in
doing so:

Amended—This indicates the property record is being amended.

Short Title and Location—This is typically a legal description and an address.

Current Value of Debtor's Interest—This is the value of the debtor’s or debtors’ interest in the property,
without deduction for any secured claim or exemption.

Amount of Secured Claim—This is the total of the liens held by secured creditors against the property;
individual claim amounts are entered on Schedule D. For example, if a property is secured by more than one
claim, the total amount of all claims against the property should be entered here, and the individual claims
against the property split out by creditor on Schedule D.

7. Apply the proper exemptions, as appropriate, by selecting This property qualifies for one or more exemptions
and then choosing the applicable options from the list of exemption categories and then entering the associated
values.

8.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

9.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule B: Personal Property?

Personal property refers to items such as automobiles, boats, and clothing. All personal property of the debtor must be
listed in Schedule B.

To complete Schedule B:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule B - Personal Property.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Form 6B in the Form 6B Guidance dialog, which is the first dialog in the interview.

5. Review and enter information in the Case Information dialog. Specifically, if the debtor has personal property,
select The debtor has items of personal property.

6. Review and provide all requested information within the Personal Property dialog, using the following information in
doing so:

Amended—This indicates the personal property record is being amended.

Type of Property— Choose the personal property category from the drop-down list.

Short Title and Location—This is typically a legal description and an address.

Current Value of Debtor's Interest—This is the value of the debtor’s or debtors’ interest in the property,
without deduction for any secured claim or exemption.

7. Apply the proper exemptions, as appropriate, by selecting This property qualifies for one or more exemptions
and then choosing the applicable options from the list of exemption categories and then entering the associated
values.

8.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

9.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule C: Property Claimed as Exempt?

Schedule C summarizes the exemption status of the debtor’s real and personal property. Information entered when
completing Schedule A and B automatically flows to and is displayed in the Schedule C interview for purposes of your
reviewing and validating that you have taken the proper exemptions. Should you need to refine exemption assignments,
you can do so directly in the Schedule C interview.

To complete Schedule C:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule C - Property Claimed as Exempt.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule C in the Form 6C Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Case Information, Claimed Exemptions, Real Property, and Personal Property
dialogs.

6. Make any changes as necessary.

7.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule D: Creditors Holding Secured Claims?

Schedule D details claims for which there is an outstanding past-due amount. All creditors holding secured claims against
property of the debtor must be listed in Schedule D.

To complete Schedule D:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule D - Creditors Holding Secured Claims.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule D in the Form 6D Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Case Information dialog.

6. Review and provide all requested information within the Creditors Holding Secured Claims dialog, using the
following information in doing so:

Creditor field—Either enter the creditor's name in the field, or click the drop-down arrow on the field and
choose a creditor's name you've already entered in the Master Address List. (If you choose an existing creditor,
the address fields will automatically be populated.)

Full Account Number fields—Enter the requested account numbers in the respective fields.

Note:
o To enter multiple contact names and addresses for the creditor, select Include information for an

additional contact.
o To add the information you've entered to the Master Address List so it can be used in additional cases,

select Add this creditor information to the TopForm database.

Nature of Lien—Enter the applicable option such as Mortgage.

Property Description—This is the item of debtor’s property against which the creditor holds a claim and for
which you entered all information when completing Schedules A and B.

Property Value—This is the fair market value of the debtor’s or debtors’ interest in the property, without
deduction for any secured claim or exemption.

Amount of Claim—This is the lien amount held by the given creditor against the given item of property.

Claim Status—This indicates the claim’s status as contingent (one that depends on the occurrence of a
future event that may or may not happen, such as an agreement to pay a debt only if the original obligor
defaults), unliquidated (one in which an amount is unknown because it has not yet been decided by
agreement or by a court and cannot be readily determined by operation of legal principles) or disputed.

7.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

8.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule E: Creditors Holding Unsecured Priority Claims?

Schedule E details creditors whose claims are unsecured. All creditors holding unsecured priority claims against the
debtor must be listed in Schedule E.

To complete Schedule E:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule E - Creditors Holding Unsecured Priority Claims.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule E in the Form 6E Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Court Information dialog.

6. Review and provide all requested information within the Creditors Holding Unsecured Priority Claims dialog,
using the following information in doing so:

Claim Type—From the drop-down list of claim types, choose the option applicable to the given click claim (i.e.,
Taxes and Other Certain Debts).

Creditor field—Either enter the creditor's name in the field, or click the drop-down arrow on the field and
choose a creditor's name you've already entered in the Master Address List. (If you choose an existing creditor,
the address fields will automatically be populated.)

Address fields—Enter the contact information for the entities holding unsecured priority claims against the
debtor as of the date of filing of the petition in the address fields.

Note:
o To enter multiple contact names and addresses for the creditor, select Include information for an

additional contact.
o To add the information you've entered to the Master Address List so it can be used in additional cases,

select Add this creditor information to the TopForm database.

Consideration for Claim—Specify what the debtor received in exchange for the claim or, in some cases, the
nature of the claim (e.g., "a deposit for uncompleted construction" or "1998 income taxes").

Claim Status—This indicates the claim's status as contingent (one that depends on the occurrence of a
future event that may or may not happen, such as an agreement to pay a debt only if the original obligor
defaults), unliquidated (one in which an amount is unknown because it has not yet been decided by
agreement or by a court and cannot be readily determined by operation of legal principles) or disputed.

Amount of Claim—This is the lien amount held by the given creditor against the debtor.

Amount Entitled to Priority—Type the appropriate monetary value.

7.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

8.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule F: Creditors Holding Unsecured Nonpriority
Claims?

Schedule F details creditors whose claims are unsecured. All creditors holding unsecured nonpriority claims against the
debtor must be listed in Schedule F.

To complete Schedule F:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule F - Creditors Holding Unsecured Nonpriority Claims.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule F in the Form 6F Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Court Information dialog.

6. Review and provide all requested information within the Creditors Holding Unsecured Claims dialog, using the
following information in doing so:

Name of Creditor field—Either enter the creditor's name in the field, or click the drop-down arrow on the field
and choose a creditor's name you've already entered in the Master Address List. (If you choose an existing
creditor, the address fields will automatically be populated.)

Address fields—Enter the contact information for the entities holding unsecured priority claims against the
debtor as of the date of filing of the petition in the address fields.

Note:
o To enter multiple contact names and addresses for the creditor, select Add Additional Contacts.
o To add the information you've entered to the Master Address List. so it can be used in additional

cases, select Add this creditor information to the TopForm database.

This claim is subject to setoff—Select this option if the creditor owes money to the debtor which can be
offset against the money the debtor owes to the creditor.

Consideration for Claim—Specify what the debtor received in exchange for the claim or, in some cases, the
nature of the claim (e.g., “a deposit for uncompleted construction” or “1998 income taxes”).

Claim Status—This indicates the claim’s status as contingent (one that depends on the occurrence of a
future event that may or may not happen, such as an agreement to pay a debt only if the original obligor
defaults), unliquidated (one in which an amount is unknown because it has not yet been decided by
agreement or by a court and cannot be readily determined by operation of legal principles) or disputed.

7.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

8.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule G: Executory Contracts and Unexpired Leases?

Schedule G details executory contracts and unexpired leases and indicates whether they will be rejected or assumed and,
possibly, additional information depending on jurisdiction. All executory contracts and unexpired leases of the debtor must
be listed in Schedule G.

Note:
An executory contract, generally speaking, is one for which significant aspects of performance remain due on
both sides. A detailed discussion of executory contracts and unexpired leases may be found in Collier Consumer
Bankruptcy Practice Guide ch. 15

To complete Schedule G:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule G - Executory Contracts and Unexpired Leases.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule G in the Form 6G Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Court Information dialog.

6. If the debtor has executory contracts or leases, select The debtor has executory contracts or leases and then
review and provide all requested information within the Executory Contracts dialog.

7.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule H: Co-Debtors?

Schedule H summarizes information related to codebtors.

To complete Schedule H:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule H - Co-Debtors.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule H in the Form 6H Guidance dialog, which is the first dialog in the interview.

5. Review all information within the Debtor Information dialog.

6. If the case includes a co-debtor, review and provide all requested information within the Codebtor and Claim
Information dialog.

7.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule I: Current Income of Individual Debtors?

Schedule I details the income of the debtors, and the income of all debtors must be listed in Schedule I.

To complete Schedule I:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule I - Current Income of Individual Debtors.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule I in the Form 6I Guidance dialog, which is the first dialog in the interview.

5. Review the information within the Case Information dialogs.

6. Review the information in the Debtor Information dialog. If the debtor is married, select The debtor is married.

7. Enter information about the debtor and, if necessary, the spouse, in each of the remaining dialogs.

8.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete Schedule J: Current Expenditure of Individual Debtors?

Schedule J may include several sections, depending on the choices you have previously made. Schedule J details
expenses of the debtors and, when applicable, of the debtor’s spouse, debtor’s business, and debtor’s spouse’s business.
All of the debtor’s current expenses must be listed in Schedule J.

To complete Schedule J:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Schedule J - Current Expenditure of Individual Debtors.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about Schedule J in the Form 6J Guidance dialog, which is the first dialog in the interview.

5. Review the information within the Debtor Information and Case Information dialogs.

6. Enter expenses in the different Expense dialogs.

7. Enter information about the debtor and, if necessary, the spouse, in each of the remaining dialogs.

8.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I complete the Summary of Schedules?

The Summary of Schedules outlines important details about your case, including the following:

The schedules you have selected to include in your filing

The number of pages that will print for each schedule

Note:
Until the entire case is complete, the total page count may not be accurate.

Reviewing the Summary of Schedules is an important step in preparing an initial filing.

To complete the Summary of Schedules:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate the Summary of Schedules.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about the Summary of Schedules in the Form 6 Summary Guidance dialog, which is the
first dialog in the interview.

5. Review the information within the Case Information and Debtor Information dialogs.

6. In the Document Information dialog, select which schedules will be included in the filing.

7. Review the information in the Property and Claim Totals and Income and Expenses dialogs. Fields to which you
may make changes are not grayed.

8. When you have completed the interview, click Finish. Your answers are saved and you are returned to the main
TopForm window.
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How do I complete the Form 22: Statement of Current Monthly Income and
Means-Test Calculation?

Form 22 must be completed for certain individual debtors filing Chapter 7, for individual debtors filing Chapter 11, and for
all debtors filing Chapter 13.

The interview process for Form 22 varies depending on chapter type, with the interview for Chapter 7 and 13 cases
containing multiple dialogs corresponding to the categories of information used in determining current monthly income and
calculating the Means Test (for Chapter 7 cases) or determining Disposable Income (for Chapter 13 cases). The interview
for Chapter 11 cases contains a few questions that are used to gather current monthly income data.

To complete Form 22A, Form 22B, or Form 22C:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate the version of Form 22 you need to file, based on the following:

If you are an individual debtor filing Chapter 7, select Form 22A - Chapter 7 Statement of Current Monthly
Income and Means-Test Calculation.

If you are an individual debtor filing Chapter 11, select Form 22B - Chapter 11 Statement of Currently
Monthly Income.

If you are any type of debtor filing Chapter 13, select Form 22C - Chapter 13 Statement of Currently
Monthly Income and Calculation of Commitment Period and Disposable Income.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about your particular form in the Form 22 Guidance dialog, which is the first dialog in the
interview. This dialog and the resources it links to contain useful information to help you know how to answer the
questions used throughout the interview.

5.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

6.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.



Collier TopForm® & File User Guide

73

Using the Different Tools Available

How do I complete the Chapter 7 preliminary means test?

Debtors planning to file a bankruptcy case under Chapter 7 must first prove they qualify to file for Chapter 7 relief. This
is typically accomplished using Form 22 - Statement of Current Monthly Income and Means Test Calculation. As a
preliminary step to completing this form, you can use the Preliminary Means Test to help determine whether presumption
arises.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Preliminary Means Test. The Preliminary Means Test appears.

3. Choose the state in which the case may be filed from the State drop-down list.

4. Enter the size of the household in the Household size field.

Note:
The Household size field consists of the number that would currently be allowed as exemptions on the debtor's
federal income tax return, plus the number of any additional dependents the debtor supports.

5. Enter the debtor's average monthly income in the Average monthly income field.

6. Click Calculate. The values you entered are computed and displayed, and a preliminary declaration of presumption
is indicated.
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How do I complete a Chapter 13 worksheet?

The Chapter 13 Worksheet is designed to help you determine whether your client is qualified to file a Chapter 13
bankruptcy plan. The tool lets you enter an estimated amount for the debtor’s proposed monthly contribution to the plan
as well as the various amounts that must be paid to the various types of creditors, including the percentage of the plan
that would be paid to the general unsecured creditors. The tool can then calculate how the contribution can be disbursed
to all affected parties. This can help you determine if the Chapter 13 plan will work for your client, or if he or she must file
in Chapter 7.

The tool also lets you compare the results of the Chapter 13 analysis with those of a Chapter 7 case. This can help you
further determine the best approach to take with your client. See How do I compare a Chapter 13 plan with a Chapter 7
filing?.

Once you have completed your analysis, you can save the Chapter 13 analysis to create a case for the debtor.

To complete the Chapter 13 analysis:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Chapter 13 Worksheet. The Chapter 13 Worksheet appears.

3. Choose the client for whom you are completing the Chapter 13 analysis from the Complete Chapter 13 analysis
for drop-down list. (If you are creating an analysis for a new client, choose New Case Analysis.)

4. Choose one of the following options:

To base the calculation on the proposed monthly income, select Proposed monthly contribution and then
enter the amount your client can contribute in the number field.

To base the calculation on the percentage to be paid to unsecured creditors, select Percent paid to
unsecured creditors and then enter the percentage of the monthly contribution that will be paid.

5. Choose the length of the plan the client can complete from the Plan length drop-down list. Your options range from
36 to 60 months.

6. Choose the trustee fee payment option from the Trustee fee drop-down list.

7. In the Administrative fees table, enter the fees that will be paid for administration of the plan (for example,
attorney's fees). These fees are paid at the outset of the plan.

8. In the Monthly maintenance paid through plan table, enter the different secured claims that need to be
considered, such as mortgage payments and automobile loan payments.

9. In the Adequate protection payments only paid through plan table, itemize the claims and provide the expected
claim amount.

10. In the Priority claims table, enter the different priority claims that need to be considered, such as spousal support,
child support, and taxes.

11. In the Secured claims table, enter the different secured claims that need to be considered.

12. In the Special non-priority claims paid in full under plan table, enter the non-priority claims that need to be
considered.

13. In the General unsecured claims table, enter any remaining claims that need to be paid out. These claims have the
lowest priority and will be paid out last within the plan.

14. Once you have entered all of the required information, click Calculate.

15. Review the calculations along the bottom of the form to determine if your client qualifies to file a Chapter 13 plan.

To save the information so it can be used to create a new Chapter 13 case, click Save. To print a copy of the analysis
form, click Print.
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For information on comparing the Chapter 13 plan with a Chapter 7 filing, see How do I compare a Chapter 13 plan with a
Chapter 7 filing?.
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How do I determine the dates of federal holidays?

When working with dates that you must define for your case, you often need to know what days the federal holidays fall
on during a given year.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Federal Holidays from the list of options on the left. The U.S. Federal Holidays tool appears in the right
pane.

3. Choose the year you want to review from the drop-down list. The list of federal holidays appears below.
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How do I calculate a different date, either in the future or the past?

Often you need to find a date sometime in the future (or even in the past). You can use the Calculate New Date tool to
identify these dates. If necessary, you can ensure the calculation only considers the 5-day business week in its formula.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Calculate New Date from the list of options on the left. The Calculate New Date tool appears in the right
pane.

3. Choose the type of calculation you want to perform from the Add drop-down list. Specifically, if you want to find a
future date, choose Add. To find a date in the past, choose Subtract.

4. Enter the number of days, months, or years you want to use in the equation in the respective boxes. (You can enter
data in only one of these fields, or you can enter data in all of the fields.)

5. Enter the date you want to use as the starting point in the Starting date box.

6. Optionally, select Calculate date using business dates to make sure only the 5-day business week is included in
the equation. (Federal holidays are also considered if you select this option.)

7. Click Find Date. The new date appears at the bottom of the tool.
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How do I find the number of days between dates?

You can find the number of days between two or more given dates. Optionally, you can exclude weekend dates (Saturday
and Sunday) and federal holidays from the calculation.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Find Time Between Dates from the list of options on the left. The Find Number of Days Between Dates tool
appears in the right pane.

3. Enter the dates you want considered in the First date, Second date, and Third date boxes.

4. Optionally, select Use only business dates in calculation to make sure only the 5-day business week is included
in the equation. (Federal holidays are also considered if you select this option.)

5. Click Count Days. The number of days between the dates you entered appears to the right of the date fields.
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How do I calculate my client's average monthly income?

You can calculate what your client's average monthly income is, based on either a 6-month or 12-month period. This
calculation uses the client's gross monthly income.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Average Monthly Income from the list of options on the left. The Average Monthly Income tool appears in
the right pane.

3. Enter the client's gross income in the Gross income box.

4. Choose whether you want the average for 6 months or 12 months from the Period drop-down list.

5. Click Calculate. The average is listed at the bottom of the tool.
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Working with Chapter 7 Cases

How do I complete the Chapter 7 preliminary means test?

Debtors planning to file a bankruptcy case under Chapter 7 must first prove they qualify to file for Chapter 7 relief. This
is typically accomplished using Form 22 - Statement of Current Monthly Income and Means Test Calculation. As a
preliminary step to completing this form, you can use the Preliminary Means Test to help determine whether presumption
arises.

To do this:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Preliminary Means Test. The Preliminary Means Test appears.

3. Choose the state in which the case may be filed from the State drop-down list.

4. Enter the size of the household in the Household size field.

Note:
The Household size field consists of the number that would currently be allowed as exemptions on the debtor's
federal income tax return, plus the number of any additional dependents the debtor supports.

5. Enter the debtor's average monthly income in the Average monthly income field.

6. Click Calculate. The values you entered are computed and displayed, and a preliminary declaration of presumption
is indicated.
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How do I complete the Form 22: Statement of Current Monthly Income and
Means-Test Calculation?

Form 22 must be completed for certain individual debtors filing Chapter 7, for individual debtors filing Chapter 11, and for
all debtors filing Chapter 13.

The interview process for Form 22 varies depending on chapter type, with the interview for Chapter 7 and 13 cases
containing multiple dialogs corresponding to the categories of information used in determining current monthly income and
calculating the Means Test (for Chapter 7 cases) or determining Disposable Income (for Chapter 13 cases). The interview
for Chapter 11 cases contains a few questions that are used to gather current monthly income data.

To complete Form 22A, Form 22B, or Form 22C:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate the version of Form 22 you need to file, based on the following:

If you are an individual debtor filing Chapter 7, select Form 22A - Chapter 7 Statement of Current Monthly
Income and Means-Test Calculation.

If you are an individual debtor filing Chapter 11, select Form 22B - Chapter 11 Statement of Currently
Monthly Income.

If you are any type of debtor filing Chapter 13, select Form 22C - Chapter 13 Statement of Currently
Monthly Income and Calculation of Commitment Period and Disposable Income.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about your particular form in the Form 22 Guidance dialog, which is the first dialog in the
interview. This dialog and the resources it links to contain useful information to help you know how to answer the
questions used throughout the interview.

5.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

6.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I compare a Chapter 13 plan with a Chapter 7 filing?

Using financial information you know about the debtor, you can compare the outcomes between a Chapter 7 filing and a
Chapter 13 plan.

To do this:

1. Complete the Chapter 13 Worksheet.

2. At the bottom of the Chapter 13 Worksheet, locate the section called Chapter 7 Comparison.

3. Enter the required amounts in the appropriate fields.

4. Click Calculate.
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Completing Means Testing

About the Bankruptcy Means Test

Under the Bankruptcy Abuse Prevention and Consumer Protection Act of 2005 (P.L. 109-8), a consumer bankruptcy
petitioner's current income and expenses may create a presumption of abuse. The Means Test is the calculation used
to determine whether or not the presumption of abuse arises. The calculation incorporates regional median income
information from the Census Bureau and various deductions based on national and local Internal Revenue Service
standards. If the presumption of abuse arises and cannot be overcome by special circumstances, the debtor is not entitled
to file under Chapter 7, and would instead have to file under another chapter, typically Chapter 13. Chapter 13 uses the
same deductions and calculations to determine disposable income.

Included with Collier TopForm™ & File is a repository of data from the Internal Revenue Service (IRS) and the U.S.
Census Bureau for use in performing the calculations necessary to file Chapter 7 and Chapter 13 bankruptcies, including
means testing to determine whether a case qualifies for Chapter 7.

Collier TopForm & File includes both Form 22A - Statement of Current Monthly Income and Form 22C - Chapter 13
Statement of Currently Monthly Income and Calculation of Commitment Period and Disposable Income, which are
used to complete the Means Test. Although Form 22C, for Chapter 13 bankruptcies, does not refer to means testing, it
uses the same questions, calculations, and deductions as the B22A Means Test to determine disposable income.
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How do I complete the Form 22: Statement of Current Monthly Income and
Means-Test Calculation?

Form 22 must be completed for certain individual debtors filing Chapter 7, for individual debtors filing Chapter 11, and for
all debtors filing Chapter 13.

The interview process for Form 22 varies depending on chapter type, with the interview for Chapter 7 and 13 cases
containing multiple dialogs corresponding to the categories of information used in determining current monthly income and
calculating the Means Test (for Chapter 7 cases) or determining Disposable Income (for Chapter 13 cases). The interview
for Chapter 11 cases contains a few questions that are used to gather current monthly income data.

To complete Form 22A, Form 22B, or Form 22C:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate the version of Form 22 you need to file, based on the following:

If you are an individual debtor filing Chapter 7, select Form 22A - Chapter 7 Statement of Current Monthly
Income and Means-Test Calculation.

If you are an individual debtor filing Chapter 11, select Form 22B - Chapter 11 Statement of Currently
Monthly Income.

If you are any type of debtor filing Chapter 13, select Form 22C - Chapter 13 Statement of Currently
Monthly Income and Calculation of Commitment Period and Disposable Income.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
form.

Note:
See Completing a Document for details on working within this window.

4. Review the information about your particular form in the Form 22 Guidance dialog, which is the first dialog in the
interview. This dialog and the resources it links to contain useful information to help you know how to answer the
questions used throughout the interview.

5.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

6.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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Working with Chapter 13 Plans

About Chapter 13 Filings

The ability to create a Chapter 13 plan is one of the strengths of Collier TopForm™ & File. Working with Chapter 13 plans
involves the following:

Pre-qualifying a case for Chapter 13 filing

Completing the necessary documents

Creating, validating, and refining the plan

For a detailed discussion of the requirements and standards for Chapter 13 plan confirmation, see Chapter 14 of the
Collier Consumer Bankruptcy Practice Guide.

Note:
Collier TopForm & File includes a generic Chapter 13 plan accepted in many jurisdictions, as well as numerous
jurisdiction-specific plans. If your jurisdiction requires a specific plan format that is not currently offered in Collier
TopForm & File, please send us a copy so we can review it for inclusion in a future release:
 

Matthew Bender & Company, Inc.

Attention: TopForm Enhancements, Bankruptcy Editorial Group

744 Broad Street, Newark, NJ 07102
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Preparing a Chapter 13 Filing

As an aid in helping to determine the feasibility of filing a given case under Chapter 13, Collier TopForm™ & File allows
you to pre-qualify a case for Chapter 13. Once run, the pre-qualification scenario can be saved and printed for your
reference. See How do I complete a Chapter 13 worksheet? for details.

Additionally, in calculating the payment schedule, Collier TopForm & File also analyzes how the Chapter 13 Plan
distribution compares to a Chapter 7 distribution. Everything in the Chapter 13 Plan revolves around making the payment
schedule meet the needs and payment abilities of the debtor. See How do I compare a Chapter 13 plan with a Chapter 7
filing? for details.

Because a Chapter 13 plan is based on the debtor's resources as they relate to outstanding claims, you should complete
the following schedules before creating the plan itself:

Schedule A — Includes lists of real property owned by the debtor, such as houses, cabins, and other land.

Schedule B — Includes lists of personal property owned by the debtor, such as cars, boats, clothing.

Schedule D — Shows claims for which there is an outstanding past-due amount.

Schedule E and Schedule F — Lists the creditors whose claims are unsecured.

Schedule G — Lists the executory contracts and unexpired leases and indicates whether they will be rejected or
assumed and, possibly, additional information depending on jurisdiction.

Schedule I — Lists the income of the debtors.

Schedule J — Lists the expenses of the debtors and, when applicable, of the debtor's spouse, debtor's business,
and debtor's spouse's business.

Chapter 13 Fee Application — Shows the attorney's fee.

Once you have completed these forms, you are ready to create the Chapter 13 Plan, which is the culmination of preparing
a Chapter 13 filing. The heart of the Chapter 13 Plan is the payment schedule, which details how the claims will be paid
off. Everything in the Chapter 13 Plan revolves around making the payment schedule meet the needs and payment
abilities of the debtor.
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How do I complete a Chapter 13 worksheet?

The Chapter 13 Worksheet is designed to help you determine whether your client is qualified to file a Chapter 13
bankruptcy plan. The tool lets you enter an estimated amount for the debtor’s proposed monthly contribution to the plan
as well as the various amounts that must be paid to the various types of creditors, including the percentage of the plan
that would be paid to the general unsecured creditors. The tool can then calculate how the contribution can be disbursed
to all affected parties. This can help you determine if the Chapter 13 plan will work for your client, or if he or she must file
in Chapter 7.

The tool also lets you compare the results of the Chapter 13 analysis with those of a Chapter 7 case. This can help you
further determine the best approach to take with your client. See How do I compare a Chapter 13 plan with a Chapter 7
filing?.

Once you have completed your analysis, you can save the Chapter 13 analysis to create a case for the debtor.

To complete the Chapter 13 analysis:

1. Click the Tools menu. The page changes to show the available tools.

2. Choose Chapter 13 Worksheet. The Chapter 13 Worksheet appears.

3. Choose the client for whom you are completing the Chapter 13 analysis from the Complete Chapter 13 analysis
for drop-down list. (If you are creating an analysis for a new client, choose New Case Analysis.)

4. Choose one of the following options:

To base the calculation on the proposed monthly income, select Proposed monthly contribution and then
enter the amount your client can contribute in the number field.

To base the calculation on the percentage to be paid to unsecured creditors, select Percent paid to
unsecured creditors and then enter the percentage of the monthly contribution that will be paid.

5. Choose the length of the plan the client can complete from the Plan length drop-down list. Your options range from
36 to 60 months.

6. Choose the trustee fee payment option from the Trustee fee drop-down list.

7. In the Administrative fees table, enter the fees that will be paid for administration of the plan (for example,
attorney's fees). These fees are paid at the outset of the plan.

8. In the Monthly maintenance paid through plan table, enter the different secured claims that need to be
considered, such as mortgage payments and automobile loan payments.

9. In the Adequate protection payments only paid through plan table, itemize the claims and provide the expected
claim amount.

10. In the Priority claims table, enter the different priority claims that need to be considered, such as spousal support,
child support, and taxes.

11. In the Secured claims table, enter the different secured claims that need to be considered.

12. In the Special non-priority claims paid in full under plan table, enter the non-priority claims that need to be
considered.

13. In the General unsecured claims table, enter any remaining claims that need to be paid out. These claims have the
lowest priority and will be paid out last within the plan.

14. Once you have entered all of the required information, click Calculate.

15. Review the calculations along the bottom of the form to determine if your client qualifies to file a Chapter 13 plan.

To save the information so it can be used to create a new Chapter 13 case, click Save. To print a copy of the analysis
form, click Print.



Collier TopForm® & File User Guide

88

For information on comparing the Chapter 13 plan with a Chapter 7 filing, see How do I compare a Chapter 13 plan with a
Chapter 7 filing?.
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How do I create a Chapter 13 plan?

The creation of the Chapter 13 plan is the culmination of preparing a Chapter 13 filing.

The heart of the Chapter 13 Plan is the payment schedule, which details how the claims will be paid off. In calculating the
payment schedule, Collier TopForm™ & File also analyzes how the Chapter 13 Plan distribution compares to a Chapter
7 distribution. Everything in the Chapter 13 Plan revolves around making the payment schedule meet the needs and
payment abilities of the debtor.

Note:
For a detailed discussion of the requirements and standards for chapter 13 plan confirmation, see Chapter 14 of Collier
Consumer Bankruptcy Practice Guide.

Once you have validated your Chapter 13 settings, pre-qualified the case for filing under Chapter 13, started a Chapter 13
case, and prepared all necessary documents, you can then create the Chapter 13 plan.

To create a Chapter 13 plan:

1. While viewing the Case tab for the case you are working on, click the Forms subtab.

2. In the Initial Filing list, locate Chapter 13 Plan.

3. Double-click the form. A new window appears, showing the interview questions you need to answer to complete the
plan.

Note:
See Completing a Document for details on working within this window.

4. Review the information about the Chapter 13 plan in the Form Guidance dialog, which is the first dialog in the
interview. This is an imperative step, as the information contained in this dialog will help you understand how to
complete this form.

5.
Continue with the interview by completing the questions in each dialog. (Click Next or Previous (  or ) to
review these dialogs.)

Note:
Some of the questions or dialogs in the interview include additional information to help you complete the plan. To

view this help, click the  button, either in the dialog title bar or next to the answer field.

6.
When you have completed the interview, click Finish ( ). Your answers are saved and you are returned to the
main TopForm window.
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How do I compare a Chapter 13 plan with a Chapter 7 filing?

Using financial information you know about the debtor, you can compare the outcomes between a Chapter 7 filing and a
Chapter 13 plan.

To do this:

1. Complete the Chapter 13 Worksheet.

2. At the bottom of the Chapter 13 Worksheet, locate the section called Chapter 7 Comparison.

3. Enter the required amounts in the appropriate fields.

4. Click Calculate.
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Completing Due Diligence Tasks

About Retrieving Credit Report Data Electronically
Important:
Costs for obtaining credit reports are separate from those associated with your Collier TopForm™ & File license.

As a way of enhancing efficiency, Collier TopForm™ & File allows you to retrieve reports from credit bureaus using either
the MicroBilt™ service or CIN Legal Data Services. Upon retrieval, you can import the trade-line data into the applicable
schedules for the chosen case or review and/or incorporate the data at some later date.

Before using this feature, however, you must obtain credentialing from the applicable service provider. Once you have
obtained the needed credentialing, you may retrieve credit reports and import trade-line data for any existing case.

The credit report retrieval process differs somewhat depending on the service you will be using, as follows:

When working with CIN Legal Data Services, you can retrieve only merged reports, whereas with the MicroBilt
service, you may choose to retrieve a report from the Experian, Equifax, or TransUnion credit bureaus.

The MicroBilt service assigns a single user ID and password combination for use by all attorneys in your firm,
whereas CIN Legal Data Services assigns a single client code to your firm but separate user IDs and passwords for
each attorney in your firm.



Collier TopForm® & File User Guide

92

How do I obtain credentialing for using Microbilt™ or CIN Legal Data Services?

As a prerequisite to retrieving credit-report data via Collier TopForm™ & File, you must obtain credentialing from the
MicroBilt™ service and/or CIN Legal Data Service. Once you become credentialed, you will be provided with sign-in
information required when subsequently retrieving credit-report data via Collier TopForm & File.

To obtain credentialing for either Microbilt or CIN:

1. Edit a case.

2. Click the Due Diligence tab. The view changes to show the different services available.

3. In the left pane of the window, click the link for the service you want to use. The right pane changes to show the
credit report request form.

4. Scroll to the bottom of the pane and click Register, in the Links section. A Web page appears.

5. Follow the instructions on the page to complete the registration process.
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How do I retrieve and import credit report data from MicroBilt™?

Collier TopForm™ & File allows you to retrieve reports from the MicroBilt™ service. Upon retrieval, you can import the
trade-line data into the applicable schedules for the chosen case as well as review and incorporate the data at some later
date.

To retrieve a credit report and import trade-line data:

1. At the Case tab for the case you are working on, click the Due Diligence subtab. The view changes to show the
different credit reporting agencies in the left pane.

2. Click MicroBilt. The right pane updates to show the different MicroBilt options.

3. In the Configuration section, complete the following steps:

Choose the Default schedule into which you anticipate importing the majority of the trade-line data.

Enter the User name and Password in their respective fields as provided to you upon being credentialed by
the MicroBilt service.

Note:
You can save your sign-in information. To do this, click Save. If you need to edit the information again, click
Edit.

Choose the desired type of credit report (i.e., Experian, Equifax, or TransUnion) from the Credit bureau drop-
down list.

4. In the Debtor Information section, enter the required information in each of the fields, noting the following:

Selecting a Debtor (from the Select Debtor drop-down list) is necessary only when the case involves a joint
debtor.

The debtor’s Social Security Number (SSN) must be entered in the format ###-##-####.

The Apt. Number is optional.

Address information must be collected as individual elements, as indicated by the fields Street Number, Street
Name (minus type, such as Boulevard), and Street Type (such as Boulevard).

Address Type options are Standard, P.O. Box, or Rural Route.

5. When you are finished providing all information, click Get Credit Report. The Due Diligence - MicroBilt Credit
Report Preview window appears, displaying the trade-line data retrieved from the designated credit bureau.
The Preview includes two main areas: The creditor information, which appears above the creditor listing. As you
click on individual rows in the creditor listing, the information in this section is updated to show the information in
readable format.

6. In the Available Claims table, indicate which claims you want to import to the chosen case, using the following as a
reference in doing so:

To choose individual creditors to import, select the check box for the creditor. To choose all creditors, select
Select To Import All.

To verify the destination schedule for each claim you intend to import to the chosen case, in the Schedule
column, click the drop-down arrow and select the desired destination schedule.

Note:
o Credit report data you import can be used when you complete Schedules D, E, F, and G. Once you

indicate the schedule into which you want to import the data, that data will be available when you
complete the related schedule.

o To change the schedule for all creditors in the list, choose the new schedule from the Schedule drop-
down list located in the top row of the table and click Set.



Collier TopForm® & File User Guide

94

7. When you are finished verifying information for all claims, click Import Claims. A message box appears, confirming
the claims were successfully imported.

8. Click OK.

Note:

The links provided in the Microbilt Links section let you explore additional Microbilt options. Click any of them for
further information.

To view a readable version of the credit report, go to the Case > Home tab and double-click its link in the
Documents pod.
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How do I retrieve and import credit report data from CIN Legal Data Services?

Collier TopForm™ & File lets you retrieve reports from the CIN Legal Data Services. Upon retrieval, you can import the
trade-line data into the applicable schedules for the chosen case as well as review and/or incorporate the data at some
later date.

To retrieve a credit report and import trade-line data:

1. At the Case tab for the case you are working on, click the Due Diligence subtab. The view changes to show the
different credit reporting agencies in the left pane.

2. Click CIN Legal Data Services. The right pane updates to show the different CIN options.

3. In the Configuration section, complete the following steps:

Choose the Default schedule into which you anticipate importing the majority of the trade-line data.

Enter the applicable User ID, Password, and Client code as provided to you upon being credentialed by CIN
Legal Data Services.

Note:
You can save your sign-in information. To do this, click Save. If you need to edit the information again, click
Edit.

4. In the Debtor Information pod, enter the required information in each of the fields.

5. Repeat these steps if there is a co-debtor, entering the information in the Enter Co-Debtor Information section of
the form.

6. When you are finished providing all information, click Get Credit Report. The CIN Credit Report Preview window
appears, displaying the trade-line data retrieved from the designated credit bureau.
The Preview includes two main areas: The creditor information, which appears above the creditor listing. As you
click on individual rows in the creditor listing, the information in this section is updated to show the information in
readable format.

7. In the Available Claims table, indicate which claims you want to import to the chosen case, using the following as a
reference in doing so:

To choose individual creditors to import, select the check box for the creditor. To choose all creditors, select
Select To Import All.

To verify the destination schedule for each claim you intend to import to the chosen case, in the Schedule
column, click the drop-down arrow and select the desired destination schedule.

Note:
o Credit report data you import can be used when you complete Schedules D, E, F, and G. Once you

indicate the schedule into which you want to import the data, that data will be available when you
complete the related schedule.

o To change the schedule for all creditors in the list, choose the new schedule from the Schedule drop-
down list located in the top row of the table and click Set.

8. When you are finished verifying information for all claims, click Import Claims. A message box appears, confirming
the claims were successfully imported.

9. Click OK.

Note:

The links provided in the CIN Links pod let you explore additional CIN Legal Data Services options. Click any of
them for further information.
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To view a PDF version of the credit report, go to the Case > Home tab and double-click its link in the Documents
pod.
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How do I review previously retrieved credit report data?

When you retrieve credit-report data, Collier TopForm™ & File saves the data to an .xml file on your system, regardless of
whether you import the data to the corresponding case at the time. This allows you to review and/or incorporate the data
at your convenience.

To do this:

1. Edit a case for which you have already retrieved credit report data.

2. Click the Due Diligence tab. The view changes to show the different services available.

3. Click the link for the service you want to view. For example, click MicroBilt. A Reports option appears in the left
pane.

4. Click the link for the report you want to view. (Reports are named using the date they were downloaded.) The right
pane updates to show the report you requested.

5. Review the previously retrieved data, then proceed as desired:

To import the trade-line data to the chosen case, follow the steps outlined for either Microbilt or CIN Legal Data
Services.

To leave the previously retrieved data unchanged, click Close.
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E-Filing Your Case Documents with the Court

About Electroncially Filing Your Forms

What is E-Filing?

Among the many features of Collier TopForm™ & File is the capability of producing electronic filings. From the schedules
and forms that you complete in Collier TopForm & File, you can generate Portable Document Format (PDF) documents,
which is the format required for transmitting filings to your bankruptcy court’s electronic filing system. You can also
add PDF documents created outside the program—specifically, credit-counseling forms for the debtor and co-debtor
—to the list of documents you manually upload to your court’s Web site. Finally, Collier TopForm & File can generate
corresponding matrix and extract files in the format required by the court.

Important:
In order to participate in your bankruptcy court’s electronic filing system, you must register with and receive training
from the court. For information about registration, training, and hardware and software requirements, please contact
your local bankruptcy court.

How It Works

When you start the e-filing process for a case, Collier TopForm & File creates a folder that contains the files to be included
in your e-filing. This folder is typically found in Documents\LexisNexis\TopForm\Cases\CaseName, where CaseName
represents the case you are working on. Numbers may be attached to the end of the folder name to help you distinguish
between like-named cases. Inside the folder, the creditor.txt and debtor.txt files are created, as well as any PDFs you
specify during the e-filing process. If you need to file an amended version of a document, you can choose to either
overwrite the existing documents or save the amended file to an Amended subfolder.

Additionally, you can set your preferences for e-filing. These preferences will be suggested each time you e-file a case.
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How do I prepare an electronic filing?

After you have configured Collier TopForm™ & File to reflect the electronic filing requirements of your local bankruptcy
court, you can prepare electronic filings.

Note:
For individual and joint-debtor filings, Collier TopForm & File requires you to complete Official Form 21, Statement of
Social Security Number, before preparing an electronic filing.

To e-file your documents with the court:

1. Open the case that you want to file electronically.

2. Click the eFile subtab to view the available e-filing options.

3. From the drop-down list at the top of the dialog box, choose either Initial Filing, Emergency Filing, Other
Bankruptcy Forms, or Jurisdictional Forms, as applicable. A list of documents for the chosen category is
displayed in the pane below.

4. Select the desired schedules and forms you want to include in the electronic filing. (To keep a form from being
included in the filing, clear the associated check box.)

Note:
You must manually select Form 21 - Statement of Social Security Numbers to include it in the filing. If you want to
include it in your filing as a separate document, move the form to the bottom of the form list and insert a file break
before it. (See the note at the bottom of this topic for instructions on using file breaks.)

5. Verify the form order. (To move a form up or down in the list, select it and click the Move Up or Move Down arrow.)

6. Make the following optional selections:

Select Print date on signature line to print the date on the signature line of schedules and forms. Then, enter
the date you want to use in the associated field.

Select Print signature line to insert electronic signature codes and signatures on schedules and forms.

Select Print amended titles to indicate whether the program should print amended titles on schedules and
forms.

Select Print only amended records to indicate whether the program should print only those records that have
been amended.

Select Use amended filing path to keep the amended schedules and forms from overwriting the original files.
(These files will be saved in a subfolder named Amended within the case folder.)

7. Choose the applicable county from the Extract county drop-down list. This name will be inserted in the extract file.

8. Select the desired method of submitting the filing:

Note:
If you intend to include documents you have manually added to the case (such as pay stubs or credit counseling
certificates), you must manually file the case. You cannot auto-file the case.

Select Auto-file with the court to submit filings in as automatic and invisible manner as possible based on
your court’s pattern for processing electronic filings.

Select Generate PDF and open court web site to manually e-file to automatically launch your browser to
your court’s Web site, where you can then complete the process of submitting the filing.

Select Generate PDF and open to create the PDF document and open it so you can review it.

Select Generate PDF only to generate the necessary PDF files without performing any subsequent action.
The files are created and copied to the case folder so you can manually e-file the documents later.

9. Once you have verified all of your e-filing settings, click Go.
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10. Depending on the option you've chosen for filing the documents, complete the remaining steps in the filing process.

Note:

By default, all documents you select in the Documents to File list will be added to a single PDF file. If you
want to separate the documents into smaller subgroups, you can insert file breaks, which indicate the first and
last form included in each PDF file. To add a file break, select the last PDF you want included in the group of
documents and click Insert file break. If you need to move the file break, select it and click the Move Up button

( ) or the Move Down button ( ). To remove a file break, select it and click Delete file break.

To set the Documents to File list back to its default state, click Reset.
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How do I specify e-filing preferences?

You can specify default properties associated with electronic filing. These properties will be suggested when you start the
electronic filing process for individual cases you are working on.

To do this:

1. From the Preferences menu, choose eFiling. The pane changes to show eFiling preferences.

2. Provide the following information:

Click Jurisdiction to specify the jurisdiction whose settings you want to modify.

In the Court ECF login URL field, enter the dedicated Internet address for filing electronically with your court.

In the ID field, enter the ID provided by the court for purposes of electronic filing.

In the Password field, enter the password corresponding to your ECF ID, and then re-enter it again in the Re-
enter password field.

In the Signature code field, enter the code that will be used for all e-signatures.

Select Acknowledge and accept compliance responsibility with redaction requirements to indicate that
you understand the redaction requirements associated with filing.

3. Click Save to save your changes.
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Context-Sensitive Help Pages
The following topics are accessible from various context-specific help links within the product:
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Due Diligence: CIN Legal Data Services (Case Tab)

The following table describes the fields and options available on the Due Diligence: CIN Legal Data Services page of
the Case tab.

Field Name Description

Default Schedule Choose the schedule into which you anticipate importing the majority of the trade-line
data.

User ID, Password, and
Client code

Enter the applicable information as provided to you upon being credentialed by CIN Legal
Data Services.

Debtor Information fields Enter the required information about the debtor in the appropriate fields.

Co-debtor Information fields If there is a co-debtor listed on the case, enter his or her information in the appropriate
fields.

Get Credit Report Click this button to retrieve the credit report from CIN Legal Data Services.

CIN Links Click any of the links to view information related to requesting a credit report through CIN
Legal Data Services.
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Due Diligence: Microbilt (Case Tab)

The following table describes the fields and options available on the Due Diligence: Microbilt page of the Case tab.

Field Name Description

Default schedule Choose the schedule into which you anticipate importing the majority of the trade-line
data.

User name and Password Enter the information in the fields as provided to you upon being credentialed by the
MicroBilt service.

Credit bureau Choose the desired type of credit report (i.e., Experian, Equifax, or TransUnion) from the
drop-down list.

Select debtor Choose the debtor (or co-debtor, if applicable) from the list so you can enter his or her
information in the remaining fields.

SSN, Street number, Street
name, Apt number, Address
type, Street type, City,
State, Zip

Enter the information required by each of these fields for both the debtor and the co-
debtor, if applicable.

Get Credit Report Click this button to retrieve the debtor's (or co-debtor's) credit report.

Microbilt Links Click any of the links to view information related to requesting a credit report through
Microbilt.
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eFile (Case Tab)

The following table describes the fields and options available on the eFile page of the Case tab.

Value Description

Filing Type Choose the type of documents you want to e-file from this drop-down list. Your options
include Initial Filing, Emergency Forms, Other Bankruptcy Forms, Jurisdictional
Forms.

Documents List Lists the different documents available for e-filing. Use the following information to work
with this list:

To select individual documents, click the check box next to a listing. To select or
clear all documents in the list, select or clear Documents to file.

To change the order documents appear in this list (and the order in which the
documents appear in the resulting PDF document that will be generated), select the

document and click the Move Up button ( ) or the Move Down button ( ) to
move it.

To indicate the last document you want included in an e-filing package, select the
document and click Insert file break. (To remove a file break, select it in the list and
click Delete file break.)

To reset the list of documents to its default status, click Reset.

Print date on signature line Select this option to print the date the form is signed on the signature line, then enter the
date in the corresponding date field.

Print signature line Select this option to insert electronic signature codes and signatures on schedules and
forms.

Print amended titles Select this option to indicate whether the program should print amended titles on
schedules and forms.

Print only amended records Select this option to indicate whether the program should print only those records that
have been amended.

Use amended filing path Select this option to keep the amended schedules and forms from overwriting the original
files.

Extract county Choose the applicable county from the drop-down list. This name will be inserted in the
extract file.

Auto-file options Select the desired method of submitting the filing:

Select Auto-file with the court to submit filings in as automatic and invisible
manner as possible based on your court’s pattern for processing electronic filings

Select Generate PDF and open court web site to manually e-file to automatically
launch your browser to your court’s Web site, where you can then complete the
process of submitting the filing

Select Generate PDF and open to open the document you wish to file in your PDF
viewer so you can preview it before filing it

Select Generate PDF only to generate the necessary .PDF files without performing
any subsequent action, allowing you to step through the process of submitting
filings from beginning to end

Go Click this button to perform the e-filing action you selected.
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Debtor (Case > Home Tab)

The following table describes the fields and options available on the Debtor pod of the Case > Home tab.

Note:
If you complete Form 1 - Voluntary Petition, the fields on this form will automatically be filled in. To do this, click the
Voluntary Petition link, located at the bottom of the Debtor pod.

Field Name Description

Case Number Enter the case number assigned by the court.

File number Enter the file number for the case.

First, Middle, and Last
name

Enter the debtor's name in the respective fields.

Debtor signature Enter the debtor's electronic signature

Address, City, State, County
of residence, Zip

Enter the debtor's address information in the respective fields.

Primary Phone / Alternate
Phone and Type

Enter the debtor's primary telephone number and indicate what type of number it is (work,
cell, or home). (Repeat this process if you want to enter an alternate phone number.)

Email Enter the debtor's email address.

Aliases Click this link to enter additional names by which the debtor has been known. (You must
save the debtor information first before you can click this link.)

Complete various
information wizards

Click any of the links to provide information that is required by several of the forms.

Save Click this button to save the information you have entered.
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Documents (Case > Home Tab)

The following table describes the fields and options available on the Documents pod of the Case > Home tab.

Field Name Description

Documents List Shows the externally created documents you want to associate with the case. These
typically include pay stubs or other documents required by your case.

Add Click this link to add documents to the list. (When you click the link, the Open
dialog box appears, where you can browse to and select the file. Supported files
include .PDF, .JPG, .BMP, .TIFF, and .TXT.)

Note:
When you add a document to this list, it is copied to the case folder, which can be
found in \Documents\LexisNexis\TopForm\Cases\CaseName.

Delete Click this link to remove a document from the list. The document is removed from the list
as well as the case folder. (It is not removed from the original folder, however.)

Folder button ( ) Click this button to view the case folder in Windows Explorer.
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Case Notes (Case > Home Tab)

The following table describes the fields and options available on the Notes pod of the Case > Home tab.

Field Name Description

Adding as Select a user's name from this drop-down list. This name represents the person adding
the note.

Tip:
To add a new user to the list of names, click Adding as and enter the name on the
next blank line of the Name table.

Note field Enter the note you would like associated with this case. You can enter as many notes as
you need.

Add Note button Click this button to save the note.

Existing notes Shows all of the notes that have previously been entered for this case.

Select all notes Lets you select all the notes in the list below.

Edit Lets you edit a note.

Delete Lets you select one or more notes to delete.

Download Notes Lets you select one or more notes to save them to disk in a PDF file.

Print Notes Lets you select one or more notes to print.
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Print (Case Tab)

The following table describes the fields and options available on the Print page of the Case tab.

Field Name Description

Filing Type Choose the type of filing for which you want to print documents: Initial Filing,
Emergency Filing, Other Bankruptcy Forms, or Jurisdictional Forms.

Documents to Print Select (or clear) this check box to select (or clear) all documents in the list. Only selected
documents will be printed.

Document List Shows the documents available to be printed. Select the check box next to each form to
print it. (To keep a form from being printed, clear the associated check box.)

Reset Click this link to set the Documents to Print list back to its default state.

Print amended titles Select this option to indicate whether the program should print amended titles on
schedules and forms.

Print only amended records Select this option to indicate whether the program should print only those records that
have been amended.

Print Click this button once you are ready to print the selected schedules and forms.

Preview Click this button to preview what the printed documents will look like. The documents will
be opened in your PDF viewer so you can examine them.
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Start New Case (File Menu)

The following table describes the fields and options available on the Start New Case page of the File menu.

Field Name Description

Case name Enter a name by which you want to identify the case you are creating.

Jurisdiction Choose the jurisdiction in which you want to file the petition.

Note:
To add jurisdictions to this drop-down list, see How do I add a jurisdiction?.

Chapter Choose which type of filing you want to create: Chapter 7, Chapter 11, Chapter 12, or
Chapter 13.

Exemption laws Choose which type of exemption laws you want to apply to the filing: federal or
jurisdiction-specific.

Debts are Select whether the debt is primarily consumer-based or business-based.

Tip:
The Code defines “consumer debt” as “debt incurred by an individual primarily for a
personal, family, or household purpose. . . .” 11 U.S.C. 101(8). The Code does not
define “personal,” “family,” or “household.” Examples of non-consumer debts are
tax and tort claims. “In applying this definition, many courts have looked to whether
the debt was incurred with a profit motive. For example, the Court of Appeals for the
Fourth Circuit . . . held that a debt arising from a divorce decree was a consumer
debt. Thus, the ground for dismissal of a chapter 7 case is not available in business
bankruptcy cases or in cases in which the debts are not primarily of a personal
nature” (6 Collier on Bankruptcy®  ¶ 707[3][a] [citations omitted]).

Debtor type Choose the type of debtor: Individual, Joint, Partnership, Corporate/Non-Public,
Corporate/Public.

Tip:
Partnerships and corporations are not eligible to file under chapter 13.

Firm Choose the law firm that will be representing the case.

Note:
See for How do I add a firm? for information on adding law firms to Collier TopForm™
& File.

Representative Choose the representative for the case.

Filing fees Choose how the filing fees will be paid: attached with the filing, in installments, or
requested to be waived.

Create Case Click to add the case to the program. Once you click Create Case, you will be prompted
to enter specific information about the debtor.
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eFiling (Preferences Menu)

The following table describes the fields and options available on the eFiling page of the Preferences menu.

Field Name Description

Jurisdiction Choose the jurisdiction you file in most frequently from the drop-down list.

Court ECF login URL Enter the dedicated Internet address for filing electronically with your court.

ID Enter the ID provided by the court for purposes of electronic filing.

Password Enter the password corresponding to your ECF ID, and then re-enter it again in the Re-
enter password field.

Signature code Enter the code that will be used for all e-signatures.

Acknowlege and accept
compliance responsibility
with redaction requirements
of Fed. R. Bankr. P. 9037

Select if you have read and understand all redaction requirements associated with filing a
case.
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Exemptions Setup (Preferences Menu)

The following table describes the fields and options available on the Exemptions Setup page of the Preferences menu.

Field Name Description

Jurisdiction Choose the jurisdiction for which you want to modify exemption law information.

Exemption laws Choose the exemption laws you want to view. To add a new exemption, click Add.

Exemptions To edit the Description, Law, Exemption Amt., or Maximum Amt., click in the desired
area and enter your changes.

To add an exemption, click in the last row of the Exemptions table and enter information
in each applicable column of the row.

To delete an exemption, click the row you want to delete and click the Delete link. Then
click OK in the confirmation window asking whether you want to delete the item.
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Mailing Labels (Preferences Menu)

The following table describes the fields and options available on the Mailing Labels page of the Preferences menu.

Field Name Description

Jurisdiction Lets you specify the jurisdiction whose preferences you want to modify.

Label format Choose the format of the mailing labels that you will use for the matrix. Your options
include:

Avery 5160 (3x10)

Avery 5162 (2x7)

BANCAP (single column)

Avery 5351 (3x11)

Labels (3x9)

Max. characters per line Choose the maximum number of characters allowed per line in matrix entries.

Labels Down (BANCAP
only)

Choose the number of labels running down the length of a sheet.

Order Select whether the matrix entries should be listed in Vertical or Horizontal order. (This
option does not apply to BANCAP.)

Up and Down Arrows (

and )

Select an entry in the matrix and click the Up or Down button to move it to a new location
on the page.

Margin values Enter the margin sizes you want to use for the matrix page.

All CAPS Select if your jurisdiction requires names and addresses to be printed in all capital letters
and without punctuation.

Remove Duplicates Select if you want the program to automatically remove duplicate creditor listings.

Include Account Number Select if your jurisdiction requires that account numbers appear on the matrix.

Start creditors on new page Select to start the list of creditors on a new page.

Debtor / Joint-Debtor /
Attorney / Trustees

Select each of these options to include the entity on the matrix.

Schedule D / Schedule E /
Schedule F / Schedule G

Select to include creditors listed in each of these schedules on the matrix/mailing label
and in the creditor.txt file (which is used when efiling).

Include Codebtors Select if you want co-debtors listed in Schedule H to appear on the matrix/mailing label
and in creditor.txt.

Additional Names Select to include a list of names that are to be included on all matrices for the given
jurisdiction and are not gathered elsewhere, such as names for the trustee or IRS.

Equity Security Holders Select to include equity security holder information.
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Matrix (Preferences Menu)

The following table describes the fields and options available on the Matrix tab of the Preferences > Mailing Labels
page.

Value Description

Jurisdiction Lets you specify the jurisdiction whose preferences you want to modify.

Label format Choose the format of the mailing labels that you will use for the matrix. Your options
include:

Avery 5160 (3x10)

Avery 5162 (2x7)

BANCAP (single column)

Avery 5351 (3x11)

Labels (3x9)

Max. characters per line Choose the maximum number of characters allowed per line in matrix entries.

Labels Down (BANCAP
only)

Choose the number of labels running down the length of a sheet.

Order Select whether the matrix entries should be listed in Vertical or Horizontal order. (This
option does not apply to BANCAP.)

Move Up and Move Down

buttons (  and )

Select an entry in the matrix and click the Move Up or Move Down button to move it to a
new location on the page.

Margin values (BANCAP
only)

Enter the margin sizes you want to use for the matrix page.

All CAPS Select if your jurisdiction requires names and addresses to be printed in all capital letters
and without punctuation.

Remove duplicates Select if you want the program to automatically remove duplicate creditor listings.

Include account number Select if your jurisdiction requires that account numbers appear on the matrix.

Start creditors on new page Select to start the list of creditors on a new page.

Blank lines between labels Select to add a blank line between each of the addresses on the label, then enter the
number of blank lines in the box.

Include: Debtor / Joint
debtor / Attorney / Trustee

Select each of these options to include the entity on the matrix.

Creditors: Schedule D /
Schedule E / Schedule F /
Schedule G

Select to include creditors listed in each of these schedules on the matrix/mailing label
and in the creditor.txt file (which is used when efiling).

Include co-debtors Select if you want co-debtors listed in Schedule H to appear on the matrix/mailing label
and in creditor.txt.

Additional names Select to include a list of names that are to be included on all matrices for the given
jurisdiction and are not gathered elsewhere, such as names for the trustee or IRS.

Equity security holders Select to include equity security holder information.
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Restore and Reimport a Database File
Note:
The information contained in these steps was taken from the Microsoft Developer Network knowledge base. Please
refer to this article for additional information from Microsoft.

Collier TopForm™ & File uses database files to store information about the cases you create, the forms you generate,
your user preferences, and so forth. However, at times you may need to reinstall the program to correct issues you
encounter while using the program. If you are a network user and you uninstall both Collier TopForm & File and SQL
Server Express (which is used to manage the database files), when you reinstall both of these programs, the installation
must create new database files, which will overwrite the existing data in these database files.

However, if you need to continue using your existing database files, you can follow the instructions below to restore and
reimport the database files.

Collier TopForm & File creates two database files, which you can restore: MasterDB (which stores information about
cases and TopForm preferences, etc.) and HotDocsDB (which stores information about the bankruptcy forms). To restore
both of these databases, complete the steps described below twice—once for each database.

To restore your existing TopForm databases:

Caution:
It is strongly recommended that you enlist the help of someone familiar with database management when performing
these steps.

1. Open the command prompt on the server.

2. From the command prompt, connect to an instance of SQL Server by using the following sqlcmd command:
sqlcmd -S Server\TopForm

Where Server is the name of the computer.

3. When connected, type the following commands:
USE [master]
GO
CREATE DATABASE [database_name] ON 
( FILENAME = N'C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL
\Data\<database name>.mdf' ),
( FILENAME = N'C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL
\Data\<database name>.ldf' )
FOR ATTACH ;
GO

Where database_name is the name of the database you want to attach (either MasterDB or HotDocsDB),
FileName is the path and file name of the database file and the log file, and FOR ATTACH specifies that the
database is created by attaching an existing set of operating system files.

4. To verify that the database has been attached, type the following two commands:

    select name from sys.databases
    go

The sqlcmd tool displays the names of all databases attached to this instance of SQL Server Express. In the list, you
should see the database name you provided in step 3.

http://msdn.microsoft.com/en-us/library/ms165673.aspx
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List of Forms Whose Data is Imported from Collier TopForm™ 10.5

The following table lists the forms available in both Collier TopForm™ 10.5 and Collier TopForm™ & File. When you
import your cases into Collier TopForm & File, the data in the Collier TopForm 10.5 form should map to the data in the
Collier TopForm & File form. However, it is recommend that you verify the accuracy of the import process by reviewing
each form in the list below.

Collier TopForm™ 10
Form Name

Collier TopForm™ & File 12 Form Name

Voluntary petition Form 1 - Voluntary Petition

Exhibit A - Exhibit to Petition Exhibit "A" to Voluntary Petition

Form B1 Exhibit C Exhibit "C" to Voluntary Petition

Exhibit D - Individual
Debtor's Statement of
Compliance with Credit
Counseling Requirement
(Debtor)

Exhibit "D" - Individual Debtor's Statement of Compliance with Credit Counseling
Requirement (Debtor)

Exhibit D -  Individual
Debtor's Statement of
Compliance with Credit
Counseling Requirement
(Joint Debtor)

Exhibit "D" - Individual Debtor's Statement of Compliance with Credit Counseling
Requirement (Joint Debtor)

(No form available in this
version)

Declaration Under Penalty of Perjury on Behalf of a Corporation or Partnership

Form 3A - Application
to Pay Filing Fee In
Installments

Application to Pay Filing Fee in Installments

Form 3B- Application for
Waiver of Chapter 7 Filing
Fee

Application for Waiver of the Chapter 7 Filing Fee for Individuals who Cannot Pay the
Filing Fee in Full or in Installments

Form 4 - Creditors Holding
20 Largest Unsecured
Claims

List of Creditors Holding 20 Largest Unsecured Claims

Declaration Concerning
Debtor's Schedules

Declaration Concerning Debtor's Schedules

Summary of schedules Summary of Schedules

Schedule A Schedule A - Real Property

Schedule B Schedule B - Personal Property

Schedule C - Property
Claimed as Exempt

Schedule C - Property Claimed as Exempt

Schedule D Schedule D - Creditors Holding Secured Claims

Schedule E Schedule E - Creditors Holding Unsecured Priority Claims

Schedule F Schedule F - Creditors Holding Unsecured Nonpriority Claims
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Schedule G Schedule G - EMappedecutory Contracts and Unexpired Leases

Schedule H - Codebtors Schedule H - Codebtors

Schedule I Schedule I - Current Income of Individual Debtors

Schedule J Schedule J - Current Expenditures of Individual Debtors

Form 7 Form 7 - Statement of Financial Affairs

Form 8 - Chapter 7
Individual Debtor's
Statement of Intention

Form 8 - Chapter 7 Individual Debtor's Statement of Intention

Form 19 - Declaration
and Signature of Non-
Attorney Bankruptcy
Petition Preparer

Form 19 - Declaration and Signature of Non-Attorney Bankruptcy Petition Preparer

Form B200 Lists,
Schedules, Statements and
Fees

Required Lists, Schedules, Statements and Fees (12/08)

(No form available in this
version)

Certification of Notice to Individual Consumer Debtors (12/09)

"Form 202 - Statement of
Military Service (Debtor) /
Form 202 - Statement
of Military Service (Joint
Debtor)"

Form 202 - Statement of Military Service (08/07)

Disclosure of Compensation
by Attorney/Preparer

Disclosure of Compensation of Attorney for Debtor (12/94)

Form 21 - Statement of
Social-Security Number
or Individual Taxpayer-
Identification Number (ITIN)

Form 21 - Statement of Social Security Numbers

Means Test Form 22A - Chapter 7 Statement of Current Monthly Income and Means-Test Calculation

Means Test Form 22B - Chapter 11 Statement of Current Monthly Income

Means Test Form 22C - Chapter 13 Statement of Current Monthly Income and Calculation of
Commitment Period and Disposable Income

Form 23 - Debtor's
Certification of Completion
of Postpetition Instructional
Course Concerning
Personal Financial
Management (Debtor)

Form 23 - Debtor's Certification of Completion of Postpetition Instructional Course
Concerning Personal Financial Management

Form 23 - Debtor's
Certification of Completion
of Postpetition Instructional
Course Concerning
Personal Financial
Management (Joint Debtor)

Form 23 - Joint Debtor's Certification of Completion of Postpetition Instructional Course
Concerning Personal Financial Management
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Form 24 Certification to
Court of Appeals

Form 24 - Certification to Court of Appeals by All Parties

Disclosure of Compensation
by Non-Attorney/Preparer

Disclosure of Compensation of Bankruptcy Petition Preparer (10/05)

Form 283 - Chapter 13
Debtor's Certifications
Regarding Domestic
Support Obligations and
Section 522(q)(Debtor)

Chapter 13 Debtor's Certifications Regarding Domestic Support Obligations and Section
522(1) (12/08) (Debtor)

Form 283 - Chapter 13
Debtor's Certifications
Regarding Domestic
Support Obligations and
Section 522(q)(Joint Debtor)

Chapter 13 Debtor's Certifications Regarding Domestic Support Obligations and Section
522(1) (12/08) (Joint Debtor)

List of Equity Security
Holders

List of Equity Security Holders
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